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1 GENERAL INFORMATION

Read through this operating manual carefully before use and become familiar with the machine.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This manual serves as an aid for the installation and operation of the product and supports the
technical staff with all operating and maintenance tasks to be performed. Furthermore, this
manual is aimed at preventing dangers to life and health of the user and third parties.

1.2 Who Is this Operating Manual Targeted to?

The operating manual provides a code of conduct for personnel tasked with the set-up,
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with
respect to the operation of gas engines and basic knowledge of electronic ignition systems are
necessary. Persons who are only authorized to operate the gas engine shall be trained by the
operating company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary handling steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE
® Notice
This symbol indicates important notices for the user. Follow these. In
addition, this symbol is used for overviews that give you a summary of the
NOTICE necessary work steps.

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.
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1 GENERAL INFORMATION

Danger

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned
precautionary measures.

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?
In the manual or the user interface, the following abbreviations / acronyms are used.

Abb.
ADV

ASC

ASO

CAN
Bus

CE

CPU

CSA

DC
DetCon

EMI

EMC

Term

Advance

Automatic Spark
Control
Auxiliary
Synchroni-
zation Output

Controller Area
Network Bus

Conformité
Européenne

Central Processing
Unit

Canadian Standards
Association

Direct Current

Detonation Control
System

Electromagnetic
Interference

Electromagnetic
Compatibility

Description

Explanation

Advanced with respect Indicates the direction for

to top dead center

Bus for control
devices / networks

Conformity with EU
directives

Central processing
unit

Direct Current

Detonation control
system

Electromagnetic
interference

timing

Automatic spark control

Output for synchronizing the
MIC3 and other controllers

Asynchronous serial
connection system for linking
control units

Mark based on EU legislation
for certain products in
conjunction with product safety

Organization that defines
standards, inspects products
for safety compliance, and
issues pertinent certifications.

Serves to prevent major engine
damage that can be caused by
knocking combustion.

Compatibility of electrical or
electronic equipment items
with their surroundings

Rev. 11/2014



GPI
GPO

HV

°cranksh

aft

LED

MIC

MICT

ATDC

TDC
POT

PWR
RET

usB

BTDC

Rev. 11/2014

Term
General purpose input

General Purpose
Output

High voltage

Crankshaft angle in
degrees

Light Emitting Diode

MOTORTECH Ignition
Controller

MOTORTECH
Integrated
Configuration Tool

After top dead center
Top dead center

Potentiometer

Power
Retard

Universal Serial Bus

Before top dead center

Description

Multi-purpose input

General Purpose
Output

High voltage

Light emitting diode

MOTORTECH
ignition controller

Output / current

Retarded with respect
to the top dead center

Explanation

Unit for the rotation angle of
the crankshaft

Light emitting electronic semi-
conductor

Software for MIC3
configuration

Continuously adjustable
potential divider

Indicates the direction for
timing
Serial connection system to

link a computer to external
devices



2 SAFETY INSTRUCTIONS

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, the area around the ignition system especially
holds the risk of danger due to high voltage. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

— Ignition coils and caps
— Wires of the high voltage circuit
— In- and output wiring of the ignition controller

—  Pickups and their wiring

Danger to persons with pacemakers!

Electromagnetic impulses in the wiring of the ignition system may exceed
the permissible limits of pacemakers. Persons with pacemakers must
therefore not be present in the vicinity of the ignition system being
operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless the equipment can cause risks or damages can occur, if the following
instructions are not complied with:

- The gas engine must only be operated by trained and authorized personnel.

— Operate the equipment only within the parameters specified in the technical data.
— Use the equipment correctly and for its intended use only.

— Never apply force.

— Forall work, such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the power supply and secured against unintentional
restarting.

- Perform only such maintenance and repair work as is described in this operating manual,
and follow the instructions given while working. For maintenance of the equipment, only use
spare parts supplied by MOTORTECH. Further work must only be performed by personnel
authorized by MOTORTECH. Non-compliance with the instructions will void any warranties
for the proper function of the equipment as well as the responsibility for the validity of the
certifications.

— Safety devices must not be dismounted or disabled.

- Avoid all activities that can impair the function of the equipment.

10 Rev. 11/2014



MOTORTECH

Operate the equipment only while it is in proper condition.
Investigate all changes detected while operating the gas engine or ignition system.

Ensure compliance with all laws, directives and regulations applicable to the operation of
your system, including such not expressly stated herein.

If the system is not entirely tight and sealed, gas may escape and lead to an explosion
hazard. Upon completion of all assembly works, always check the system's tightness.

Always ensure adequate ventilation of the engine compartment.

Ensure a safe position at the gas engine.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

Do not wear clothing made from synthetic materials to prevent static electricity from
building up. Your clothing should therefore be made of cotton or cotton mix materials.

Keep plastics such as vinyl and Styrofoam materials as far away from the control system, the
modules, and the work environment as possible.

Do not remove the circuit boards from the housing of the device.

2.3 Special Safety Instructions for the Device

Explosion hazard!

When the system is powered up, do not remove any connectors unless the
system is not located in a potentially explosive atmosphere.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T4.

Rev. 11/2014 11



2 SAFETY INSTRUCTIONS

Explosion hazard!

Never remove the equipment while the device is connected to a power
source unless the system is not located in an explosive environment.

Explosion hazard!

Do not remove or replace the fuse while the equipment is live.

Risk of burning!

The surfaces of the system may heat up to high temperatures.

Operational safety!

All connector screws and screw joints must be adequately tightened.

Risk of damage!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC3. Therefore, pay attention to the following when welding:
— Disconnect all electrical connections to the MIC3 prior to welding.

— Protect the MIC3 against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

2.4 Proper Disposal

After the expiration of its service life, MOTORTECH equipment can be disposed of with other
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally
friendly disposal.
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3 INTENDED USE

3.1 Functional Description
The devices of the MIC3 series are microprocessor controlled ignition systems, that are
comprised of one 32 bit main processor (CPU) and an output board.

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent
configuration.

The ignition controllers of the MIC3 series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The ignition timing is influenced by
various inputs. This can be implemented using analog input signals, a speed characteristic, or
using a serial interface (USB, CAN bus, RS485).

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected PC.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off.

3.2 Applications
The ignition controllers of the MIC3 series are designed for specific 2- or 4-stroke gas engines.
From 1 to max. 12 ignition outputs are available.

The ignition controllers supply the energy required for the corresponding ignition coils of the
gas engines and can supply signals for peripheral equipment.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of all warranties.

Rev. 11/2014 13



4 PRODUCT DESCRIPTION

4.1 Technical Data

4.1.1 Certifications
Certification pursuant to CSA is planned.

4.1.2 Mechanical Data
The MIC3 has the following mechanical characteristics.

Dimensions 250 mm X 240 mm X 89.5 mm (9.84 ' x9.45 " x 3.52 ")
(length x width x height)

Weight 3.1kg (6.8 lbs)

Shape of device See chapter Overview Drawings on page 19.

Mechanical environmental The housing is resistant to general atmospheric

conditions contaminations.

Resistant to gas engine lubricants.

Protection class: 1
Protection: IP54

The specified protection class and type is only
guaranteed if the protective cap is firmly attached to the
USB connection.

Climatic environmental Housing surface temperature: -40 °C to +65 °C (-40 °F to
conditions +149 °F)

4.1.3 Warning Notices on the Device
WARNING! Read and understand the installation and operating manual prior to installing or
making any adjustments.

EXPLOSION HAZARD! Do not disconnect while circuit is live unless area is known to be non-
hazardous. For wiring details please refer to operating manual.

CAUTION! Do not pressure wash this ignition module. Damage to electronic components may
result.

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

- Product number of the ignition controller (P/N)
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Arrangement number of the ignition controller (A/N)

Serial number of the ignition controller (S/N)

= MOTORTECH

www.motortech.de

IP/N  66.00.310-12 \
|A/N  321.12.00Q0-000-AA-0 |
|S/IN 012345678 \

4.1.5 Electrical Data
The MIC3 has the following electrical characteristics.

Feature Value

Power consumption max. 65 W with 24 V

Power supply 10t032VDC

Required current Current max. 6.0 A. An estimation of the power requirements can
be found in the table below.

Number of outputs 6 or 12 outputs

Firing angle The size of the firing angle depends on the max. overspeed. The
smallest ignition angle can be calculated using the following
formula:

. Overspeed [min™] .

Ignition Angle = —a % 360° X 2,8ms

Ignition frequency With full energy output (all 12 ignition outputs with 200 mJ), an

ignition frequency of 180 Hz as continuous load is possible. In the
event of less ignition energy or in case of a brief overload, 200 Hz
is possible. The maximum output load of 40 W must not be
exceeded.

Overspeed [min~']

50 x Number of Ignition Qutputs

Ignition Frequencys syroke =

Overspeed [min™!]

50 x Number of Ignition Outputs

1
Ignition Frequencyy, sqrope = E x

Output connector 17-pin military connector

Rev. 11/2014 15



4 PRODUCT DESCRIPTION

Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rpm and 200 mJ energy.

Outputs Voltage Required current  Voltage Required current
8 24V 2.3A 12V 4.0A
12 24V 3.3A 12V 5.0 A

Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs Values

Analog current input Working resistance 27 Q, damping 1 puF
Analog voltage input Working resistance 12.4 Q, damping 200 nF

Aux. Analog Input Supply 5to 24 V / 50 mA depending on the configuration in the MICT
Voltage

Digital Input (Start/Stop) Wiring

Input current: max. 20 mA
Ignition stop: 0 to 0.8V
Ignition release: 2.8t0 32V

Digital Input (schedule A/B)  Wiring

Input current: max. 20 mA
Schedule A: 0t0 0.8V
Schedule B: 2.8t0 32V

Go/NoGo and GPO Outputs  One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MosFET
Voltage applied: 7 to 32 V DC max.
Peak/steady current: 100 mA DC max.
Output:2.5 W max.
Internal resistance: 58 to 60 Q
Activation delay: 0.5 ms / 100 mA load max.
Deactivation delay: 0.2 ms / 100 mA load max.

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 to 60 mA.

LED Six LEDs are used as status indicators.
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Inputs and outputs Values

ASO Output TTL level (5 V)
max. current: + 10 mA

Pickup Impedance: 10 kQ
P Voltage supply for inductive pickup can be set using the MICT
atsto24V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC3 may not have a higher voltage than
+40 V peak-peak and the connected power may not exceed

1 Watt.

Ignition Coil Outputs Output voltage: 250 V max.
Output energy in normal operation mode: 200 m) max.

Output energy in the start phase: 300 m) max.

® Frequency of the pickups
. The frequency of the pickup is calculated as per the following formula.
Overspeed [min™1] . .
NOTICE Frequency = w0 X Number of Pickup Event per Revolution

4.1.6 Interfaces
Depending on the device variant, the following interfaces are available:

USB Interface
— Compatible with USB 1.1 and higher

— The connector type B is suitable only for temporary data exchange and not for permanent
connection.

—  Max. wire length 5 m (16.4 ")
CAN bus 2.0B interface

— As per IS0 11898 standard, 50 kBit/s to 1 MBit/s

— Protected against transients (automotive classification)
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4 PRODUCT DESCRIPTION

- Max. 110 participants

- Max. wire length 250 m (820 ') depending on the transfer rate

RS485 Interface
- According to TIA-485-A (03/2003)

- Max. 32 participants
- Max. data transfer rate 9.6 kBit/s to 115.2 kBit/s

- Max. wire length 100 m (328') depending on the transfer rate

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC3.

18 Rev. 11/2014



4.1.8 Overview Drawings
The connectors shown correspond to the standard MIC3 version.
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4 PRODUCT DESCRIPTION

LED functions

O Status
(O Firing
(O Pickup 1
(O Pickup 2

O GPO

Status LED flashes green if the device is running with no errors.
The LED is illuminated red if an error has occurred.
The LED is illuminated yellow if a warning has been issued.

Firing LED lights up when the ignition is active.
Pickup 1and 2 LEDs flash when the pickups are active.
GPO LED is on when the GPO is activated.

USB connection
A USB connection is located at the front of the device to connect the MIC3 to a PC.

20 Rev. 11/2014



5 INSTALLATION INSTRUCTIONS

5.1 Unpacking

Unpack the equipment, taking care not to damage it, and ensure that the operating manual is
always stored with the ignition controller and is easily accessible. Check the contents for
completeness and verify that the device type meets your application requirements.

Scope of Supply
The scope of supply of the MIC3 ignition controller consists of the following components:

— Ignition controller of the MIC3 series

— Installation set incl. four vibration dampers

— Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints
— CD-ROM with software for configuring the ignition controller

— USB interface cable for connecting the ignition controller to a PC/laptop

— Operating Manual

5.2 Installation of the Ignition Controller

The installation of the MIC3 ignition controller is implemented on a fixed bracket, e. g. on a wall
near the engine, . Use the . The installation location of the controller must be selected so that
the distance to the pickups installed on the engine ensures a reliable signal transmission to the
ignition controller, and so that there is adequate space for maintenance and repair work. The
mechanical specifications must always be complied with (refer to Mechanical Data on page 14).
The ground strap serves to ground the ignition controller and must be used accordingly. Ensure
a flawless electrical connection for this purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the warranty being voided. The permissible temperature ranges
are:

-40 °C (-40 °F) to +60 °C (+140 °F)

Risk of damage!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components.
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5 INSTALLATION INSTRUCTIONS

5.3 Determine the Installation Location of the Pickup
Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder /Compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use
only, multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate
the calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 26).
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6 WIRING OF THE DEVICE

6.1 Input and Output Wiring on the Controller

Operational safety!

All connector screws and screw joints must be adequately tightened.

g Assignment of the wire colors
Take the assignment of the wire colors of the wiring harness for the input
and output wiring from the wiring plan enclosed with the wiring harness.

NOTICE

6.1.1 Input Wiring

Input connector

A, LB
oC oD oF oF o&C
o o) oK oL oM N
oF R oS 8T QU GV
[RIPA GPrAPE R
o of of 40 o0
\ o o o oK

35-pole input connector (outside view)

Rev. 11/2014
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6 WIRING OF THE DEVICE

Assignment of the connections

Activation

Assignment
A 24V
B Ground
C PU1 Power
D PU1 Signal
E PU1 Com
F PU1 Shield
G PU2 Power
H PU2 Signal
J PU2 Com
K PU2 Shield
L CAN High
M CAN GND
N CAN Low
P CAN Shield
R Go/NoGo High
S Go/NoGo Low
T GPO High
u GPO Low

24

< X = <

ASO Out
ASO GND
Shield

Tx High

Tx Low

GND

Rx High

Rx Low
Analog GND
Analog PWR
I'n -

Iln +

Analog Shield
Start/Stop In
Sched. A/B In
GPI1

Digital GND
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6.1.2 Input Wiring — Power Supply

1 Battery Generator Control Unit
2 Supply Voltage
L+
o L- . .
~s
®
> 3 3 Battery Charger
o=
~s

Rev. 11/2014
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6 WIRING OF THE DEVICE

6.1.3 Input Wiring — Pickups

Example configuration (one active, one passive pickup)

:I{ - Camshaft

Crankshaft

PUT Com ()
PU1 Shield (T
PU2 Power @
PU2 Signal @
PU2 Com (<)

PU2 Shield

PUt Power (O
PU1 Signal @

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03 " to 0.04 ") for
MOTORTECH pickups. Please note that additional fine-tuning is required for every pickup

position due to the different conditions of the engines.

One revolution of the pickup changes the distance as follows:
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Thread Change in distance

Mi12x1 1revolution 2 1 mm (0.04 ')
5/8"-18 UNF 1 revolution 2 1.41 mm (0.05 ")
3/4"-16 UNF 1 revolution 2 1,59 mm (0,06 ')

Allocation of the Wire Colors (Example Configuration)

Camshaft

PIN Designation Wire color
C PU1 Power brown

D PU1 Signal black

E PU1 Com blue

F PU1 Shield shield
Crankshaft

PIN Designation Wire color |
H PU2 Signal white

] PU2 Com brown

K PU2 Shield shield

For problems with the pickup signal, refer to the section Pickup Input Errors on page 132.

Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be necessary
to increase the pickup sensitivity to ensure that the resultant signal
strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups on page 72.

® Aux. Pickup Supply Voltage
An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5 to 24 V and is supplied at

the connections PU1 Power and PU2 Power. Refer to the section Engine —

aleaplls Pickups on page 72.
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6 WIRING OF THE DEVICE

6.1.4 Input Wiring — Ignition Timing and Safety Devices
*) For details, see Subsequent Drawings

x = bridge for permanent authorization

Switch Start/Stop
open Ignition — OFF
- closed Ignition — ON

Switch A/B
4 open Schedule A
closed Schedule B
QEOOM®O
g g . 3 £ =09
2 = £ 2 g2 o i
% %’ -5 23 g Switch GPl1
T ® s 8 3 2 1sec. Reset CAN driver
< g D 2
] 5 sec. Reset MIC3
X
X
Two-wire transmitter Four-wire transmitter
[\ Loop Power /\ Loop Power
+V
+] +11In
\ I +1in
e -ln
@ -1 \V -1n
Shield -V Shield
R Sensor GND
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NOTICE

Aux. analog input supply voltage

An auxiliary supply voltage for the analog inputs can be configured using

the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog PWR. If using current transmitters

analog PWR is used for loop PWR and analog GND is used for sensor GND.

Please refer to the section Timing — Analog Inputs on page 76.

6.1.5 Output Wiring — Digital Outputs (Go/NoGo, GPO, ASO)

Example configuration

o +L

LK1}
[K2 }-

%)

*) DetCon or other external device (for
wiring of the DetCon, see following
example)

K1 =Go/NoGo relay
K2 = GPO relay
L27to32VDC

£ =z
= =}
¥ 3

o
8 @
=) =1
= <
o o
85 o
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GPO High @

GPQO Low

\

Asoout (<)

ASOGND (2)

Shield (><
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6 WIRING OF THE DEVICE

I I
L+ N
Relay L
——
Al l
-*— Al A2
- ( Relay
A2 —te—
High  Low
=] g l
High  Low

(L27to32VDQ)

DetCon connection

Connect the ASO output on the DetCon on the connections Timing 1 and
Timing 2 on connector Ignition Pulse.
EXAMPLE
DetCon

Ignition Pulse

Timing 1
Timing 2

Shield

ASOOUI%
=

ASO GND

30 Rev. 11/2014



6.1.6 Output Wiring — PowerView3
Connect the MOTORTECH PowerView3 visualization unit to the MIC3 as follows.

CAN Connection between Ignition Controller and PowerViews

As shown in the following illustration, you can connect the PowerViews3 directly to the
MOTORTECH ignition controller using the CAN cable delivered with the PowerViews. To do so,
you need to insert the connector in the CAN interface on the PowerViews. On the ignition
controller, connect the color-coded conductors of the CAN cable to the CAN interface.

wy ™~
E - E
&‘ jl T &I Connector for CAN interface
|- < & & = on PowerViews
|z z = <2: %
SIS 3 3G
L] [
D
o ¢ £
=l
zZ[ 51 g
4
GINIMG
& S 2 E CAN interface on the
r o -z ignition controller

I

N
(=]
2
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6 WIRING OF THE DEVICE

6.1.7 Output Wiring — CAN Bus - Interface

First device Second-to-last device
CAN Bus
c 0O c 0O
o £33 253
(o]
O 3

R=120 Q // R=120 0

CAN High (5)—A—— High
CANLow (=)
/
ol
e
s T

®W®E

= o //

= K]

25

= =

© -3
5 2 3 5 2 3
z o = I 5 2
Second device Last device

CANopen protocol

If you require information on the CANopen protocol, please contact your
MOTORTECH contact person.

CAN bus wiring
Note the following when connecting the CAN bus:
— There can be a maximum of 110 devices connected to one CAN bus.

— The maximum wire length is 250 m (820 ') depending on the transfer
rate.

— Each bus end must be fitted with a terminating resistor of 120 Q (see
drawing).
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6.1.8 Output Wiring — RS485 Interface

The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the
cable.

Two-Wire Wiring

First device Last device

Second device Second-to-last device
Four-Wire Wiring
First device Last device
(Master) (Slave)

Second device Second-to-last
(Slave) device
(Slave)
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6 WIRING OF THE DEVICE

Connection on the Ignition Controller
The RS485 interface is wired using the 6-pin plug.

A
w
B
o]
a

Tx High (—————— Tx High
Tx Low @7 Tx Low
GND (@) GND
Rx High (@——— Rx High
Rx Low @— Rx Low

Wiring of the RS485 interface
Follow these instructions for the RS485 interface wiring:

— Max. 32 devices can be connected to a bus.

— The maximum wire length is 100 m (328 ') depending on the transfer
rate.

— Each bus end must be fitted with a terminating resistor with 120 Q (as
indicated in the drawing).

6.2 Ignition Coil Wiring

Protection when using wiring rails

Every wiring rail on the engine block should be grounded to avoid
disruptions in the device caused by secondary current in the ignition coils.
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NOTICE

Ignition Coil Wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— wired in straight order

— wired in firing order

For information on straight order wiring refer to Straight Order Wiring of the
Ignition Outputs on page 36 and Engine — Parameters on page 64.

For wiring in firing order, the first cylinder in the firing order is connected to
the A1 output, the second to A2, etc.

If a different wiring was implemented, the output configuration in the MICT
must be adapted accordingly. Please note that the wiring cannot be
checked by the software (refer to Engine — Parameters on page 64).

17-pole connector (Outside view)

The table shows the pole assignments for the standard 6 and 12 cylinder versions of the MIC3.

_ 12 outputs 6 outputs

I o M m o N W >

—

Rev. 11/2014

Output A1 Output A1
Output A2 Output A2
Output A3 Output A3
Output A4 Output A4
Output As Output Ag
Output A6 Output A6
Output A7 not assigned
Output A8 not assigned
Output Ag not assigned
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6 WIRING OF THE DEVICE

Pin 12 outputs 6 outputs

K Output A10 not assigned
L Output A11 not assigned
M Output A12 not assigned
N not assigned not assigned
P not assigned not assigned
R not assigned not assigned
S not assigned not assigned
T Ground Ground

6.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use straight order wiring, it is absolutely necessary that the
MOTORTECH wiring rail for the respective engine is used and correctly
installed. Even a rotated installation can cause serious damage to the
engine, for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many
engines with predefined output configurations in the engine database. That means that if the
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT,
no other adaptation of the output configuration is necessary.

You can use straight order wiring, if:

- wiring is done via a corresponding MOTORTECH wiring harness (this is marked with the
following notice: CAUTION! Firing Order needs to be configured directly with Ignition
Controller.).

— Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).
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The execution of straight order wiring is dependent on the type of engine (in-line or V engine).

Version with 6 outputs

Pin

O Mmoo N W >

T

J

K
L
M
N
P
R
S
T

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail

Rev. 11/2014

6 outputs
Output A1
Output A2
Output A3
Output A4
Output Ag
Output A6

Ground

S1Sp1
S1Sp2
S1Sp3
S1Sp4
S1Sps
S1Sp6

In-line engine

V engine

S1Sp1
S2Sp1
S1Sp2
S2Sp2
S1Sp3
S2Sp3
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6 WIRING OF THE DEVICE

Version with 12 outputs

1] 12 outputs In-line engine V engine
A Output A1 S1Sp1 S1Sp1
B Output A2 S1Sp2 S2Sp1
C Output A3 S1Sp3 S1Sp2
D Output A4 S1Sp 4 S2Sp2
E Output Asg S1Sps S1Sp3
F Output A6 S1Spé6 S2Sp3
G Output A7 S1Sp7 S1Sp 4
H Output A8 S1Sp 8 S2Spy
J Output Ag S1Spo9 S1Sps
K Output A1o S1Sp 10 S2Sps
L Output A11 S1Sp 11 S1Sp 6
M Output A12 S1Sp12 S2Sp6
N =

P -

R =

S -

T Ground

S = connector on the wiring rail
Sp = ignition coil with the corresponding number on the wiring rail
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7 FUNCTIONS

The ignition controllers of the MIC3 series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

All angles in this operating manual are given in °crankshaft. Exceptions are
clearly identified.

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each
input. For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 72.

7.2 Monitoring of Pickup Signals

The MIC3 monitors the pickup signals. Any other errors are displayed in the MICT. For further
information on errors, please refer to the overview in section Causes of Typical Errors on page
133.

7-3 Go/NoGo

The MosFET output (Go/NoGo) is a potential-free output. It is closed during firing and opens
when the ignition switches off. The maximum switching current is 100 mA. The output can drive
an external relay that, for example, opens a gas valve.

The following errors can cause the ignition outputs to shut down:
— Overspeed

—  Pickup error

—  Error HV power supply

— Failure of the output monitoring

— Overload / temperature shut-down

- Alarms

— Insufficient supply voltage (Low Power)
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7 FUNCTIONS

7.4 Timing Correction
The ignition controller has several functions for the timing correction.

Influencing the ignition timing

Please be aware that the actual timing of the engine can also be influenced
by external signals (e. g., analog current or voltage input).

Operational safety

The MIC3 ignition controller must first be correctly configured for the engine
being used before you can start the engine.

An incorrect configuration can result in damage to the engine.

The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol.
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Per schedule:

IBase timing

| Speed curve

| Analog voltage input

| Analog current input

| Potentiometer

Global:

| Ignition timing correction

Per cylinder:

offset

Cylinder individual

Limited by the
min./max. cylinder
individual offset

7.4.1 Analog Inputs
The timing point control can be adjusted with a linear current signal. This signal can be
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a

detonation controller.

Limited by the
min./max. ignition
timing

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the

corresponding input.

Rev. 11/2014
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7 FUNCTIONS

The levels of the analog inputs can be set in the range from o to 20 mA and o to 10 V. You can
make this configuration with the MICT. Please refer to the section Timing — Analog Inputs on
page 76.

At the voltage output (Analog PWR), a configurable auxiliary voltage is supplied that can be used
for supplying power to external sensors.

Sample configurations

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

EXAMPLE — Input current: 4-20 mA

— Input voltage: 0-5V

Characteristic 4-20 mA / 0-5 V - Timing correction toward retarded.

BTDC
A

40° 4mA oV

30° 1 - o
Base Timing 30° BTDC
15° retarded ignition

15° I8

20mA 5V
50
o° Bt

Characteristic 4-20 mA / 0-5 V — Timing correction toward advanced.

BTDC
4

40° T~ 20mA 5V

30° 15° advanced ignition

159 Base Timing 15° BTDC
4mA oV

SD

o° <
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7.4.2 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the section Cylinder Individual Offsets on page 119.

Use of measuring unit

Use this setup option only if no suitable measuring unit is available for
determining the optimum timing point, so that the result of a change can be
assessed immediately.

7.4.3 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC3 ignition controllers. To create this curve, up to eight adjustable speed
points are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B —
General on page 78.

7.4.4 Timing Correction
There are two options for making corrections to the ignition timing:
— CANopen/Modbus/J1939
The field buses can be used to adjust the cylinder individual ignition timing points in 0.1°

increments by max. +/- 12.5° crankshaft, restricted by the ignition timing point limits of the
current schedule.

— MICTvia USB
Please refer to the section Runtime Adjustments — Timing on page 114.

7.5 Firing angle
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing can be calculated using the following formula:

Overspeed [min™*]

Ignition Angle = T S— % 360° X 2,8ms

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.
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7 FUNCTIONS

7.7 Schedules A/B
The MIC3 ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B , the listed parameter settings for schedule B can be selected. A
possible application for this is e. g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Please refer to Timing — Schedule A/B — General
on page 78 and Timing — Schedule A/B - Energy on page 80.

Operational Safety

If you use schedules A and B, the advanced timing point should be linked to
schedule B (switch closure). If a wire ruptures, schedule A is automatically
selected with the retarded (and thus safer) timing point.

7.8 Alarms

The MIC3 ignition controllers include 16 freely configurable alarms in total. These alarms can be
freely allocated to the general purpose output (GPO) and set depending on the following
functions:

- Limit for speed exceeded / not reached

- Limit for engine operating hours exceeded / not reached

- Limit for spark plug operating hours exceeded / not reached
— Warning active

- Error active

- Limit for temperature exceeded / not reached

- Limit for supply voltage exceeded / not reached

- Limit for global ignition timing exceeded / not reached

- Limit on the analog voltage input exceeded / not reached

- Limit on the analog current input exceeded / not reached

- Limit of the minimum spark duration exceeded / not reached
- Misfire rate (primary, single output) over limit

- Misfire rate (primary, all outputs) over limit

- Misfires per second (primary, all outputs) over limit

- Consecutive misfires (primary, single output) over limit

- Misfire rate (secondary, single output) over limit
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— Misfire rate (secondary, all outputs) over limit

- Misfires per second (secondary, all outputs) over limit
- Consecutive misfires (secondary, single output) over limit

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 82.

7.9 GPO: General Purpose Output
The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 82.

7.10 ASO: Auxiliary Synchronization Output

The ASO is an output of the MIC3 for synchronizing the MIC3 ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel
injection control.

The ASO signal is Low-Active, i. e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = trising — traling). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to
the engine rotation angle. A max. of 16 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal
precedes the raising edge by the value of the pulse width. The controller calculates the duration
of the falling edge from high-level to low-level and then back to the starting value of the high-
level.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (auxiliary synchronization output) on page 84.
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46

EXAMPLE

Application of the ASO signal
The following example will illustrate the application of the ASO signal:
- Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC3 and Valve Controller

Ignition angle in ASO signal in Pulse duration in
°crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

Schematic Representation

Level

*) active edge

The valve controller should receive the active edge of the ASO signal before
the top dead center of a cylinder. The first pulse duration should be twice
as long and thus mark the beginning of a cycle. The ASO signal generated
by the MIC3 increases by 2° each time before the ignition signal from Low
to High, as can be seen in the schematic drawing. This edge is analyzed by
the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ps versus 80 ps for other
cylinders. If the valve controller measures a pulse width of 160 ps, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition sequence,
etc.
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7.11 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here
different settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Refer to the section Timing — Schedule A/B
— Energy on page 8o.

7.12 Access Control

The MIC3 has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MIC3 is activated,
itis independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on the MIC3

A user is logged in to the Advanced Service access level on the MICT. He
changes a configuration and would like to download the change to the
MIC3. Although he has the full authorization set in the MICT, he is prompted

ERSNILE to log in with the PIN for the Level 3 (Master) on the MIC3.

A variety of functions are at your disposal in the four MIC3 operating levels. The figure below
illustrates this:

Level 3: Master

Level 2: Service

Level o: Read Only Level 1: Operator

Runtime Data

All

Access Control

Runtime Adjustment

Runtime Adjustment

Timing
Energy

Commands

Commands

Reset Position

Configuration

Alarm Commands
Error Commands
Misfire Counters

Set Engine Hous
Set Spark Plug Hours

Login

Timing

Cylinder Individual
Offsets

Download to Device

Access Control

Self Test

All
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Reset All PINs
Enable Access Control
Disable Access Control
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7 FUNCTIONS

The following functions are available on the different levels:

- Level o (Read Only)
Enables read only access for all users.

- Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on
this level.

- Level 2 (Service)
Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

- Level 3 (Master)
On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, please refer to the section Access Levels in the
MICT on page 50.
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MICT is an abbreviation for MOTORTECH Ignition Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your
engine.

8.1 MICT System Requirements
For the installation of the MICT, the following minimum requirements must be fulfilled:

— x86-compatible PC, minimum performance category Intel Pentium 4 with 2 GHz
— 128 MB free RAM

— 100 MB free disk space

— USBinterface 1.1 or higher

— Display with minimum XGA resolution (1024 x 786 pixels)

- Microsoft Windows XP, Windows 7

8.2 MICT Installation
The software for the installation of the MICT is on the CD-ROM enclosed with the ignition
controller.

To install the MICT, proceed as follows:
1. Start the installation.

— CD-ROM as installation medium
Insert the CD-ROM in the CD/DVD drive of your PC. If the Autorun function is activated for
the drive, the installation will start automatically. If the function is disabled for the
drive, the installation routine can be started with the file setup.exe from the CD-ROM
directory.

— Alternative
Copy the installation routine setup.exe to your PC. The installation is started by
executing the file.

2. Runtheinstallation.
Follow the instructions of the installation routine. Please note that the license agreement
terms must be accepted before using the MICT. If the terms are not accepted, the installation
cannot continue.

3. Install the USB driver by running the file CDMxxxxx_Setup.exe (e.g. CDM20824_Setup.exe).

» The MICT is now set up. You can connect your PC to the ignition controller via the USB
interface.
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8.3 Access Levels in the MICT

You can open the MICT via Start -> Programs -> MOTORTECH -» MICT -> MICT on your PC.

After opening the MICT, select the access level for which you have clearance. The access level
controls the options you have at your disposal in the MICT. The password required for access
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on
page 135).

B Change Access Level ﬁ

Access Level

Customer
Service
Advanced Service

Password:

oK [ concd |

The following access levels are available:

- Read Only
On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

— Customer
This level enables the configuration of the basic functions required for operation in addition
to the read-only function.

— Service
This level contains all functions for a standard installation.

— Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections will describe the options at your disposal with the Advanced Service
access level. If you have registered for a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)
The configuration pages are divided into the following sections:

s
B unnamed mc3” (MICIRLLZ - MICT ey |
[Tt Device Settings Document Jools Help
PECEEYEE YY1 ] Ee
[ | Configuration Page ,“""‘““
+ Engine || Eone Secten Engne Informaton
T Engine Manufackrer Series Troe [New Engne Configwation|  Seected Engne Summary
A !c“:'”::‘:b [azax E0R Series E2842E302 MAN - £284216322
e gostion St | Cazerpillar E2E Series E2842E312 e
! Ignition Coils | Claric £32 Series E2842LE302 Do a1 cvde &
Pickups }ceoper Bessemar E2842LE312 y
« W | Ik E2842LE322 | Firing Angles
ke ol 1 Guascor E284ELE32Z i
- | Ingersoll Rand E2876E302 1200
4 [ Schedule A | Jenbacher E2876E312 2100
General Liebhers E2876LE202 o
Energy A E2876LE302 3600
Nordberg r2076TE302 450.0
o [ Schedule8 iy s
General 5.0
Sequence 500.0
Energy Superior 690.0
! Miscellaneous Haukesha 0.0
4 Inputs/Outputs
Alarms
ASO1
Inputs
4 Miscellaneous
| Communication
| Information
MOTORTECH does not sssume babiity for i
/i\ are found.
1f your engne i not avadabie n the kst contact MOTORTECH service please.
| @ COM3 IDMICHA.12 (171 [0000ac01]) ADVSERVICE Full Access Version: 12899

Item no. Area

1 | Menu Bar

Toolbar

Navigation bar
Configuration section
Status bar

The functions in the menu bar, navigation bar and the toolbar as well as the configuration
section will be described in the following.

The status bar provides you with the following information (from left to right):

— Status Display
Indicates whether a connection is established with the controller:

— Green: Connection established
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— Red: The connection was interrupted and is being restored

— Gray: The connection is not established and is not being restored

— Indication of the interface being used for the connection to the device
- Indication of the device ID
— Indication of the access level of the user in the MICT

- Indication of the operating level for the MIC3 if the access control feature was activated and
the user has logged in with a PIN

- Indication of the MICT program version

8.5 Menu Bar and Toolbar
The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:
Symbol Menu Function
™ File -> New Creates a new configuration.
= File -> Open Opens an existing configuration.
File -» Save / Saves the current configuration.
E File -> Save As
File -> Close Closes the current configuration.
File -> Open trace Opens a runtime data record (trace file).
Please refer to the section Runtime Data on
page 89.
File -> Open pickup trace Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup -
Trace on page 57.
© File -> Change Access Level Changes the MICT access level for accessing
K the configuration data and functions.
o File -» Print Prints the current configuration.
o
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Symbol Menu

f-.a File -» Print to PDF File

File -»> Print Preview

File -» Quit

Device -» Connect

Device -» Download to device

E] Device -» Disconnect
W

B

Device-»> Upload from Device

Device -» Runtime data

D Device -5 Log

Device -» Runtime adjustments
4l

Device -» Cylinder individual
offsets

Device -» Self test

Device -» Pickup trace

Rev. 11/2014

Function

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.

Cuts the connection to the device.

Downloads configuration data from the PC to
the device. Refer to Working with
Configurations on page 61.

Uploads configuration data from the device to
the PC. Refer to Working with Configurations
on page 61.

Opens the window Runtime data. Please refer
to the section Runtime Data on page 89.

Opens the window Log (Advanced Service
only). Please refer to the section Log on page
111.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime Adjustments on
page 112.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on page
119.

Opens the window Self Test (Service and
Advanced Service only). For this read section
Self Test on page 56.

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup -Trace on page 57.
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Symbol

54

Menu

Device-» Set spark plug operating
hours

Device -» Set engine operating
hours

Device -» Set date and time

Device -» Send command -»> Reset
misfire counters

Device -» Send command -»
acknowledge operational errors

Device -» Access Control

Device -> Temperature Extremes

Settings -> Language

Settings -> Online update settings

Settings -» Temperature scale

Settings -»> Display by cylinders

Document -> Schedule Curve

Tools -» Coils

Function

Opens the window Set spark plug operating
hours.

Opens the window Set engine operating hours.

Opens the window Set date and time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operating errors are acknowledged. This
can only be implemented while the engine is
not running.

The setup for the access controls for the MIC3
are described in a separate section. Please
read the chapter Access Control for the MIC3
on page 59.

Opens the Temperature Extremes window in
which the minimum and maximum
temperatures of the controller and output
boards are displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Please refer to the section Online Update
Settings on page 55.

Opens the window Select Temperature Scale,
in which you can change the unit for the
temperatures shown in the MICT.

Currently not used.

Opens the window Schedule Curve. Please
refer to the chapter Schedule Curve on page
120.

Opens a database with information on
MOTORTECH ignition coils.
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Symbol Menu Function

Help -»> Help Opens the online help function.

Help -> About MICT Opens detailed information on the MICT.

8.6 Online Update Settings

® Perform regular online updates
MOTORTECH is constantly expanding its databases. Perform regular online
updates to make optimal use of the opportunities that the MIC3 provides.

NOTICE

The MICT uses data from an engine database and a coil database for the configuration. Such
data can be updated with automatic online updates. The settings for the update can be entered
with the following entry in the menu bar:

Settings -»> Online update settings

24 Online Update Settings i

7] Enable automatic database updates
Use 3 proxy to access the web
http-Proxy:
Port:

[_snowtog | [ updatenion | o J[ conce |

You have the following options:

— Enable automatic online updates
Use the checkbox to activate and disable the automatic online updates. As the default
setting, the online update is activated and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Usea proxy to access the web
Using the checkbox, you can activate settings for Internet access via a proxy server, which
you can then set up by entering http Proxy and Port.

— Show Log
Use this button to open a window in which the online updates performed are logged.

- Update Now
Use this button to manually start an online update.
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8.7 Self Test

Operational safety!

If you carry out a self-test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs.

Proceed in the MICT as follows:

Device -» Self Test

24 Self Test lelo

WARNING

In using the self test feature it is aribcal that the fuel to the engine

/1 ) has been shut off and the engine purged of any fud gas. Fakure to
do this could result in damage to equipment and nearby pereonnell

Status Cydes Cyde Time - All Configured Outputs
9 Uienied 9 period 29384 (3] 19
@) iiied 1 Frequency 41010 /% Hz
O acive  Ouiputs Control
@ Al
@ Ready

(s1~) (46 0]

@ COM3 ID MIC3: 12 (1.7.1 [0000ac01])

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

Locked The ignition controller is in a state in which no self test can be done. For example, there
is an error or a configuration is currently being downloaded into the device.

- Active
The self test is running.

- Ready
The ignition controller is ready and the self test can be started.
You have the following options:

- Cycles
Specify whether the number of cycles is unlimited or set at a specific number.
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— Outputs
Specify whether all outputs or only a defined output should be fired during the self test.

—  Cycle Time - All Configured Outputs
Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If
you only set one output for the self test, this would still only fire once per cycle.

— Control
Start or stop a self test using the corresponding buttons.

8.8 Pickup -Trace

The traces of the pickup signals support you in checking the behavior of the used pickup and
thus, for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. If an error occurs during operation, the record is stopped so that the

pickup can be analyzed shortly before the error. The records can be downloaded from the device
at any time.

Proceed in the MICT as follows:

Device -» Pickup trace

Pickup Trace
Q Example of a pickup trace for a configuration with two pickups:
- Pickup input 1 (cam):

EXAMPLE Single event from the camshaft

- Pickup input 2 (trigger):
Trigger disk type N-1 with 160-1 events from the crankshaft

"gf MICT Fickup Trace (=)@ s |
E L I
momo | tzom r'me___[ﬁ&‘m"l " oo
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Operation
The following options are available via the menu in the window:

Open
Opens a previously saved pickup trace.

Save as
Saves a pickup trace as a .putrace file.

Close
Closes the pickup trace.

There are the following options for the display of the pickup signals:

58

Zoom In/Out

Using the mouse scroll wheel to zoom in or out of the displayed record range. Alternatively
you can also use the plus and minus keys on the keyboard. The Zoom function gives you the
option, for example, of also analyzing the trigger signal more precisely (in the Pickup Input
figure).

(24 MICT Pickup Trace lole S
= - - - Pickqp Traoe ] ) ]
5
TR O
:g 132452.379ms
o
20000 | 125000 |13uT.I|_mal ' ]Ius.lnuol T laooe | 14s.000
ime [ms

Move displayed range
With the right mouse button pressed you can move the displayed range along the time axis.

Measuring

You can measure distances and the number of events in the displayed range by holding
down the right mouse button to highlight a section. You can find the following information in
the window:

— Position on the time axis

— Time difference (A) between the two selected points
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— Number of events counted in the selected period

24 MICT Pickup Trace [E= )
File
Plckup Trace
5
o
8 Iﬂli IIAVARATN |
(%1
% 139071.459 ms
2 A = 1631463 ms
Input 1 (positive): B events, min. @eﬂod 199.919 ms, max. period: 199.922ms
e ' v o : !
120.000 125.000 130000 135,000 140,000 145,000
Time [ms]

Error analysis
The pickup traces support you, for example, in analyzing the following errors:

- Configuration of the pickup does not agree with the wiring (e. g. trigger disk configuration,
allocation of the inputs, allocation of the shafts).

— One or more pickups have failed.

Pickup -Trace

The pickup signals are only recorded on the inputs that are configured in
the MICT. No signals are recorded if the pickup input configuration is not
valid.

8.9 Access Control for the MIC3

If the access control to the MIC3 is activated, access to the following areas is possible with a PIN
only:

- Runtime Adjustment (Reset, ignition timing, energy, calibration of the secondary voltage
estimation and calibration of the secondary short-circuit monitoring)

— Commands (Alarms, Error Commands, Set Engine/Spark plug Operating Hours, and Self
Test)

— Configuration (Transferring a configuration to the MIC3)
The access control regulates the accesses to the device via the MICT. For explanations

concerning access control to the MIC3 and the delimitation of the access levels in the MICT, refer
to section Access Control on page 47.

The access control functions can be accessed in the menu bar via:

Device -» Access Control
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8.9.1 Enabling/Disabling Access Control

@ Enabling and disabling access control

As a default setting, the access control is not activated, and all PINs are set

to 00oo0. Once the access control has been activated, and the PINs were
changed, these PINs will continue to be used. To activate the access control
again, you will need the PIN for level 3 (Master). It is therefore
recommended to reset all PINs before disabling.

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Resetting all
PINs on page 61.

To enable or disable the access control, proceed as follows:

1. Open the input dialog via Device -» Access Control -> Enable or Disable the Access Control.
2. Enterthe PIN for the level Master (Level 3).

3. Confirm the input with OK.

8.9.2 Login/Logout

If the access control is activated, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:
1. Open the input dialog via Device-> Access Control -»> Login.
2. First select the level you wish to log on to.
3. Enterthe PIN for the desired level.
4. Confirm the input with OK.
> You are now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.
After completing the log-in, you can log out again as follows:

Device -» Access Control -> Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:
1. Open the input dialog via Device -» Access Control -> Change PIN.
2. First select the level for which you wish to change the PIN.

3. Enterthe current PIN for the desired level.
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4. Enter the new PIN in the two subsequent fields.

5. Confirm the input with OK.

> The PIN for this operating level has now been changed.

8.9.4 Resetting all PINs

To reset all PINs, proceed as follows:
1. Open theinput dialog via Device -»> Access Control -»> Reset all PINs.

2. Ifyou are not yet logged into the Master (level 3) level, you will be prompted to log in with
the relevant PIN.

Accept the input with OK.

4. Toresetall PINs, you will once again be prompted to enter the PIN for the Master (level 3)
level.

5. Accept the input with OK.

> AllPINs are now reset to the value oooo.
To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1. Inthe menu bar, select the entry Device -»> Access Control -> Get reset all PINs request key to
open a window with the same name.

2. Send the request key with the serial number to your service contact partner at MOTORTECH
(refer to Customer Service Information on page 135). This key is valid only for the respective
controller and only for a certain amount of time.

> Your information will be verified, and you will receive an authorization key from your
contact partner.

3. Open with the menu entry Device -» Access Control -> Input of authorization keys to reset all
PINs of the same window name.

4. Enter the authorization key received in the input field.
5. Accept the input with OK.

» Ifthe input was correct, all PINs are reset to the default value oooo.

8.10 Working with Configurations

To ensure that the MIC3 correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC3 as configuration data.

You can use the MICT to perform the following for these configurations:
— Create

— Open
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Edit

Save as a file
Download to the MIC3
Upload from the MIC3

8.10.1 Create, Open, Save

]

Click on the symbol to create a new configuration and select the corresponding
device type. The device type corresponds to the first five digits of the
arrangement number, which you can find on a label on your device.

@1 Select Device Type

=

Select the device type you want to configure:

4 Ignition Controllers
> MIC8S0
4 [MIC3
MIC3:d.12 (12 cutputs)
MIC3:1.06 (6 cutputs)
Mic4
MICS
4 Stepper Motor Cards
VariStep
VariStep3

[l ]

— Click on the symbol to open a saved configuration.

21 Open Configuration File

@Q-\ « Eigene Dokumente » MICT

<2 ] [ MiCT dorchsveher

Organisieren ¥ Meuer Ordner
Name

|| Engine_Lmic3
| Engine_lLmic3

Dateiname:

)
Anderungsdatum GroBe
11 K8

11 k8

v [MIC3 Configuration Files (*.mic =

Click on the symbol to save the configuration currently displayed in the MICT to

a data carrier.

=
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8.10.2 Upload, Download
< Click on the symbol to upload the current configuration from the MIC3 to the

g’g MICT. The MICT first establishes a connection to the connected MIC3 if

' necessary.

% Click on the symbol to download the configuration set in the MICT to the MIC3.
h g This function can only be executed while the ignition is not active. This action

overwrites the existing MICT configuration. The MICT first establishes a
connection to the connected MIC3 if necessary.

Existing configuration is cleared!

If you download a configuration to a MIC3, the previous configuration is
deleted and the new settings are immediately implemented.

® Runtime adjustments
If you change a configuration stored in the MIC3 via runtime adjustments,
the configuration must be re-uploaded from the device so that the changes

NOIIEE are displayed in the MICT's configuration views.

8.10.3 Compatibility Information

The following situations can arise if you upload a configuration from the MIC3 to the MICT that
does not correspond to the status of your MICT or if you open this type of configuration in the
MICT:

— Novalues are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

— The configuration contains function values that are not support by the MICT.
The following situations can arise if you download a configuration from the MICT to a MIC3
whose firmware does not correspond to the status of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

— The configuration contains function values that are not support by the firmware.

If you download a configuration into the MIC3 and are notified of functions that are not
supported by the MICT, you should check the MIC3 settings. Re-upload the configuration from
the MIC3 to the MICT. You can then see which settings are not transmitted to the MICT.
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Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC3 functions without restriction.

8.11 Configuration

The window opens after you select the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration
data are then displayed in the configuration section and can be processed. The following
sections will describe the settings and adjustments you can implement in the different areas.

8.11.1 Engine — Parameters

11 unnamed.mic3* (MIC3x1.12) - MICT =S
File Device 3Settings Document Tools Help
L T BT & H " G 7 m
AHFRS IR EA0EEA
Configuration Page |Bmmnstacs
« [Engine | Engine Selection Engine Information
| Parameters Engine Manufacturer Series Type [New Engine Configuration|  Selected Engine Summary
| Cylinder Names - - -
IR E08 Series | | e2e42e302 MAN - E2B421LE322
Ignition Outputs Caterpillar E28 Series E2842E312 " E
! Ignition Cails Clark E52 Series E2842LES02 Eogme TYpe: K cildac:
Pickups Cooper Bessemer E2842LE312
# Timing m Eziuuzszz E;mg Angles
Analog Inputs Guascor E2848LE322 20.0
Ingersoll Rand E2876E302 120.0
4 Schedule A Jenbacher E2876E312 2100
| General Liebherr E2876LE202 204
Energy MAN E2876LE302 3800
4 ) Schedule B Nordbery E2876IE302 :sigg
Ruston 2
General s 570.0
equence 600.0
Energy Superior 650.0
| Miscellanecus Waukesha 0.0
4 Inputs/Outputs
Alarms
| ASOL
Inputs
4 Miscellaneous
Communication
Information
__ MOTORTECH does not assume liabiity for the information in the engine database. Please contact MOTORTECH if discrepandies
1f your engine is not avaiable in the list contact MOTORTECH service please.
@ COM3 1D MIC3.12 (1.7.1 [0000ac01]) ADV.SERVICE Full Access Version:1.28.2
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Engine Selection
The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.

Wiring in firing order is assumed as standard. If straight order wiring is supported for the
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output
configuration.

24 Wiing [ ==

Piease select the type of wiring you are using.

In case of custom wiring please select wiring in fiing order and adjust the output canfiguration
afterwards.

wired in firing order
wired in straight order (MOTORTECH AlphaRai)
@ wired in straight order (user defined arientation)

Col 1 7|9 of |1
8| |0 ol |2
9l |e ol|3
0|9 Ol |4
ullo| |of|s
2| |o]| |of|s Coi1
oy, 58 Cyl. 14
. 7-12 Fi Wl 16
[__change orientaton of rai | | change hamess | [ change orientation of rai |

Lo J

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
AlphaRail. The harness is marked with the following information: CAUTION! The firing order
needs to be configured directly in the ignition controller. The ignition coils on the wiring rail
are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the wiring rail is
marked in the Wiring view.

— Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 36 (for example with an open wiring harness or
via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your
selection. If you want to use a different wiring, these settings must be adapted appropriately.

If the pertinent engine is not available in the database, settings can also be entered by selecting
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke in the column Series, then the number of cylinders,
and the ignition offset of the engine as needed. After making your selections, the right hand
section Engine Information will display a summary of the parameters selected.
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The summarized data are transferred to the subsequent configuration page Ignition Outputs.
The values displayed there can only be changed by users with authorization to access the
Advanced Service level.

@ Engine database

MOTORTECH does not assume liability for the information in the engine
database. Please contact MOTORTECH if discrepancies are found.

New Engine Configuration

Staff with authorization for the Advanced Service level additionally have the option of entering
the engine data manually, i.e. without selecting entries from the engine database. For this
purpose, click on the New Engine Configuration button and select the engine type, number of
cycles, and number of cylinders in the dialog box opening up. Additional information can be
entered on the configuration page Ignition Outputs.

24 Dialog =
Engine Type: [¥ -]
Strokes: [stoe ]
Number of Cylinders: s ~|

Note: Specify Firing Order and Firing Angles on the Ignition Outputs Page!

ok ][ cond |
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8.11.2 Engine — Cylinder Names
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To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you
can individually name each cylinder. The schematic representation of the plan view of the
selected engine supports you in this. Enter the following settings:

Enable Cylinder Names

Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. Refer to the section Engine — Parameters on page 64. If you have
activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs.

Bank Name
Enter a name for the respective cylinder bank.

Cylinder Names
Enter a name for the respective cylinder.
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o
- ® §
currently not used

- Invert order of the banks for display
currently not used

8.11.3 Engine — Ignition Outputs
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Make adjustments to the following settings as needed:

— Number of Outputs
Select the number of outputs.

- Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.

- Column: Output
Select the number of the respective output.
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— Column: Angle
Enter the firing angle for each output.

Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

Selecting the number of outputs enables access to the fields for the configuration of the
outputs. By default, the ignition outputs are distributed so that cylinder 1 of the ignition
sequence is always allocated an ignition angle of 0°. The ignition angle for each output results
from the addition of the ignition spacing to the respective previous output.

Operational safety

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged!

The allocation of outputs to the device's output connector contacts and the cylinders is
determined by the wiring. The user must take the wiring into account during the configuration; it
cannot be checked by the software.

® Interval between two ignitions
The interval between two ignitions must be min. 1.7 ms. During the check,
the configured overspeed is used in the calculation.

NOTICE
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8.11.4 Engine - Ignition Coils
(B3 unnamed.mic3* (MIC3xL.12) - MICT =)
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Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MIC3.)

@ Only use measured ignition coils

To operate the MIC3, only ignition coil types measured by MOTORTECH may

be used. Allignition coils used must correspond to the part number
selected in the drop-down list. Different coil types must not be mixed and
also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MIC3 is currently not
used.
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Secondary Diagnosis

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil function is not supported, the calibration of the secondary voltage
estimation and the calibration of the secondary short-circuit monitoring are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each
individual cylinder. E. g. this allows different cable lengths on the engine to be compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You
can adjust the secondary voltage estimation while the engine is running in the runtime
adjustments (refer to Runtime adjustments — Secondary Voltage Estimation Calibration on page
117).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can
adjust the secondary short detection in the runtime adjustments while the engine is running
(refer to Runtime adjustments — Secondary Short Calibration on page 118).

Secondary Short Enable Voltage:
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

- The secondary short detection is always activated at a value of o kV.

— The secondary short detection is always deactivated at a value of 65.535 kV.
Secondary Short Sensitivity:

The permitted value range depends on the set ignition coil.

E. g. set the sensitivity of the short-circuit detection as follows:

— The sensitivity is high at a value of 0.98.

— The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups
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s Active pickups

Check when using active pickups that the auxiliary supply voltage is
configured for your application.

Pickup Setup Information
The settings made in the Pickup Setup section were summarized once again in the section
Pickup Setup Information.
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Pickup Setup
Enter the following settings in this section:

— Predefined Setup
Select the pickup configuration suitable for your application from the list. The
configurations available for selection depend on the previously entered settings.

— Index/Reset Position
Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.

—  Pickup Sensitivity
Open the pick list and select the desired sensitivity level for the pickup from the list offered.
This setting overwrites the value of the pre-trigger voltage if the latter was defined in the
user-defined pickup set-up.
— High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

- Medium
Standard setting of the MICT. This is a trade-off between start-up speed and sensitivity.

- Low
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

— Trigger/Cam Teeth Number
Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

— User-defined
Staff authorized to access the Advanced Service level can, in addition to the standard
settings access, use a manual setup option by clicking on the User-defined button.

21 Pickup Setup &
Fidap Tnputs
Input. Tipe No. of Events Speed Active/Passive  Pre-Trigger [V]
Pdup Input 1 (Camp [RAL =5 P [camsarT ~| [actvehigh ~] 75
Pickup Input 2 (Trigger):. [NONE =] [0 CAMSHAFT ) )

Trigger Disc Type, Defeult = NONE

Rev. 11/2014 73



8 SETTINGS VIA THE MICT

74

Type

Select the type of events that will occur on the respective input for each pickup input.
Type and number of events are defined by the discs or ring gears used. If you decide not
to use a pickup input, select the entry not used from the list. You can set the following
types:

N

Disk, which causes a uniformly distributed number (N) of events (per rotation), e.g. a
ring gear with 160 teeth (N=160).

N+1

Disk type N with one additional event, e.g. a disk with 12 teeth and one additional tooth
for the index signal (N=12).

N+1 expanded index range

Disk type N with an additional event, e.g. with one additional disk with 12 teeth and one
additional tooth for the index signal (N=12). The permitted range for the index signal is
expanded to 75 % of the tooth period. An incorrect direction of rotation of the engine
cannot be detected by this setting.

N-1

Disk type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal
N-2

Disk type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Individual Magnet

You will always use these two types together for a disk with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disk, has a reverse polarity. Thus, the disk supplies two signals that
can be analyzed by a pickup.

Single Event

Disk that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1 and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.
The number of events must lie between 3 and 500. Additionally, it must be ensured that
the sum of the frequencies at the pickup input does not exceed the limit of 10 kHz at the
pre-set overspeed.

Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.
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— Active/Passive
Select the pickup to be used from the pre-defined pick list:
Passive
passive pickup
Active (low)
active pickup with High level as quiescent level
Active (high)
active pickup with Low level as quiescent level

— Pre-Trigger
Enter a value between 0.1V and 7.5 V for every pickup in order to set the pickup
sensitivity. Signals that fall short of the set voltage will not be analyzed. A low pre-set
value therefore results in a high sensitivity level, a high value results in a low sensitivity
level.

Pickup setup information

The respective latest setting in the area of the pre-defined or arbitrary
pickup settings is transferred to and displayed under Pickup Setup
Information.

Aux. Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24 Vis possible.

Speed Settings
Enter the following settings in this section:

Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall
not exceed 1/7 of the nominal speed.

Security Speed

Enter the security speed (max. half the nominal speed). Below the value entered, the ignition
can be switched on and off as desired. If the ignition is deactivated during operation above
the set speed, the ignition cannot be immediately reactivated. Only when the ignition no
longer reads a speed, i.e., the engine has come to a standstill, can the ignition be
reactivated.

Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.
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— Overspeed
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.

- Max. Power-on Speed
Enter the maximum permitted start speed at which the MIC3 starts sending ignition pulses.
Avalue of 6000 rpm is set as the default value: The MIC3 can be activated at the starter
speed and immediately send ignition pulses.
For a value of o rpm the MIC3 can only start sending ignition pulses once it has registered
that the engine is at a standstill.

8.11.6 Timing — Analog Inputs
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g Auxiliary supply voltage

Check with the configuration of the analog inputs, that the set auxiliary
supply voltage corresponds to your application.

NOTICE

Analog Inputs Base Settings
The timing adjustment can be made using two analog input signals, which can be set within the
following limits:

— Analog Current Input: 0-20 mA
— Analog Voltage Input: 0-10 V
Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,

you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e. g. wire break).

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on
page 78.

Aux. Analog Input Supply Voltage

An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value
between 5 and 24 V.
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8.11.7 Timing — Schedule A/B - General
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Schedule A General Settings

The MIC3 offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured
the switch is ignored. The configuration options for schedule B are identical to those for set A.

- Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e. g. natural gas for the setting for this type of gas).

Ignition Timing Limits

Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs
will be limited to this range relative to the respective top dead center of the pertinent cylinder.
The global timing can then not be shifted beyond this range by any adjustments.
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Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits
entered and is a static portion of the global timing.

Analog Inputs
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input
signal. A Default can be entered for the signals, if a Failure Threshold is defined in the window
Timing — Analog Inputs for the respective entry. If the signal is below the Failure Threshold, the
timing is offset by the error value. The offset remains until the signal again exceeds the lower set
limit.

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things,
the adjustment possibility in the window Cylinder Individual Offset. In addition the limits also
apply to the corresponding adjustment signals from all other sources, for example via the field
buses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from
the list, the corresponding number of fields is activated for input.

The first speed point is always set to o RPM. All other timing points are assigned with the value
by which the signal is to be offset when the respective speed is reached. For the last speed
point, the timing of the nominal speed should be entered. Please note that the speed points
must always be entered in ascending order.
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8.11.8 Timing — Schedule A/B - Energy

1 unnamed.mic3* (MIC3xL.12) - MICT (= [E .
Eile Device Settings Document Jools Help
[ =d = 5 2 71
AEIHS I SaSs OOEF
V(Onﬂgurxrmn Page | scheduie A Energy settngs
« [Engine Start Phase
Parameters. Speed Limit: 600 RPM
Cylinder Names Tane it | 3 -
fgnition Outputs Start phase ends i both lits are exceeded.
Ignition Coils
Pickups Spark Duration: 300 s
4 Timing Spark Intensity: 70 Homa
inslog Jputs Max. Breakdown Voltage: 30 o v
“ Schedule A s : =
General Energy Limit: 300 s m
Energy (Bmited by nominal speed)
4 [} Schedule B :
General ome G e
Energy Spark Duration: 201 & s
Miscellanecus Spark Intensity: 60 < mA
gL Ma, Breakdown Voltage: 30 3w
Alarms
ASOL EnergyLimit: 200 im
Inputs
+ I Secondary diagnostics available if max, breakdown voltage s set in range 38 kY to 40 kV. Additonally it is required that the
Communication /—i“ energy kit is set sufficently high.
Information \_/ Start phasa: max. breakdown voltage out of range suitable for secondary diagnostics
Normal operation: max. breakdown voltage out of range sutable for secondary diagnostics
@ COM3 1D MIC3x1.12 (1.7:1 [0000ac01]) ADV. SERVICE Full Access Version:1.28.2

You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both.
If you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you
only want to use one criterion, set the other values to o. If you do not want to set a start phase,
set the two values to o.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the Energy Limit field to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

Required supply voltage for energy control

Depending on the output configuration and the energy settings, for a
correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
the required supply voltage is displayed in a notice in the window Timing —
Schedule A/B - Energy.

8.11.9 Timing — Miscellaneous
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You can specify how fast the changes of the timing should be executed.
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- Maximum Firing Angle Change Per Cycle
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both
directions, i. e. between two firings of a cylinder. If the specified ignition timing shift is
larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms
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The MIC3 ignition controllers include a total of 16 configurable alarms that can be allocated to
the general purpose output.

— Description

You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.

— Function
The alarms can be used depending on the following functions:

— unused
— Speed above threshold / below threshold

— Engine operating hours above threshold / below threshold
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— Spark plug operating hours above threshold / below threshold

— Warning active

— Error active

— Temperature above threshold / below threshold

— analog voltage input over threshold / under threshold

— analog current input over threshold / under threshold

— Global ignition timing above the threshold / below the threshold
— Supply voltage above threshold / below threshold

— Min. spark duration above threshold / below threshold

— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) over limit

— Consecutive misfires (primary, single output) over the threshold
— Misfire rate (secondary, single output) over limit

— Misfire rate (secondary, all outputs) over limit

— Misfires per second (secondary, all outputs) over limit

— Consecutive misfires (secondary, single output) over the limit

Threshold
Input of desired threshold value.

Hysteresis
Input of desired hysteresis value.

Delay

Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered.

Permanent — Keep output activated until alarm is acknowledged

If this box is checked, the output remains permanently active until the alarm is
acknowledged. If the box is not checked, the output remains active only for as long as the
alarm is active.

Log Events
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.

Outputs
Activate the checkbox GPO1, so that the general purpose output is activated when the alarm
is triggered.
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- GPO1
Configure the general purpose output as Normally closed or Normally open.

8.11.11 Inputs/Outputs — ASO1 (auxiliary synchronization output)
(B3 unnamed.mic3* (MIC3xL.12) - MICT =)

;ile Device Settings Document Tools Help
SITEE-PAL N Rl N5 [EiE
| aso1

Configuration Page

4 [EngiBe [t ofponts: 1~ Angle Reference: [ACTUAL ANGLES DEPENDING ON GLOBAL TIMING v |
Parameters.

Cylinder Names Ay Angie [ Puise Width [ys] Pont N Angle [ Puise Width [us]

Ignition Qutputs
9 P 0.1 200 7

! Ignition Coils !
Pickups 2
# Timing 3
Analog Inputs 4 0.0 10 1
4 Schedule A F
General
Energy 6
el Schedule B
Energy
| Miscellanecus
4 Inputs/Outputs
Alarms
| ASOL
Inputs
4 Miscellaneous
Communication

Information

Q COM3 1D MIC3x1,12 (1.7.1 [0000ac01]) ADV. SERVICE Full Access Version:1.28.2

With the auxiliary synchronization output, freely definable impulses depending on the angle of
the crankshaft can be generated. For the output, the user defines whether the angle will be
absolute or based on the global timing. The output can generate between 1 and 12 impulses and
only be assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 45.

- No. of Points
Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 ps synchronous with the
first cylinder in the ignition sequence. You can get this setting via the button Configure for
DetConz/2o0.
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— Angle Reference
Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps.

Maximum impulse duration

Please note that the duration of the impulse can be entered as max. 300 ps.
Input of higher values will not be accepted by the system.

8.11.12 Inputs/Outputs — Inputs
(23 unnamed mic3* (MIC3+1.12) - MICT =)

Eile Device Settings Document Tools Help

AHFSS IiNSO0lE O

Configuration Page | ik Sett
4 Engine | Edesiigd
Parameters GPIL: [CAN reset (1s pulse), device reset (5 s puise) ~ |
" Cylinder Names
Ignition Outputs
| Ignition Coils
" Pickups
4 Timing

Analog Inputs
4 (] Schedule A
" General
Energy
. Schedule B
| General
| Energy
7 Miscellaneous
4 Inputs/Outputs
Alarms
| ASOL
1 Inputs
4 Miscellaneous
Communication

| Information

@ COM3 IDMIC3:.12 (1.7.1 [00002c01]) ADV.SERVICE Full Access Version:1.28.2

The multi-purpose input GPI1 can be used to perform a CAN-reset or a device-reset externally
(e. g. by a master control). A high pulse of 1 second results in a reset of the CAN-driver and a high
pulse of 5 seconds results in a device-reset.
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You can activate and disable the GPI1 using the drop-down list.

8.11.13 Miscellaneous — Communication
(84 unnamed.mic3* (MIC3¢1.12) - MICT EE=x=)
_

File Device Settings Document Tools Help

AHFHS 11 R% OO0lE ©

Configuration Page [Pmmuncaion
# (Engine | ean
Parameters o, s
! Cylinder Names
Ignition Qutputs
| Ignition Coils CANopenNode ID: 30
Pickups
# [Timing ALLIN-ONE (1939)
Analog Inputs 31939 Baudrate: 250 kBitfs. -
4 Schedule A @ C

General
Energy
4 Schedule B
General
Energy
| Miscellaneous
4 Inputs/Outputs
Alarms
| ASOL
Inputs
4 Miscellaneous
| Communication

Information

Q COM3 IDMIC3d.12 (1.7.1 [0000ac01]) ADV.SERVICE Full Access Version:128.2

CAN
Clicking on the CAN checkbox enables or disables the CAN interface on the device.

- ALL-IN-ONE (J1939)/CANopen
Please select the desired protocol, depending on whether you want to set the
communication for the ALL-IN-ONE or for another device. For example, for a connection to
the PowerViews3, select CANopen.

- J1939
The J1939 source address can be assigned between o and 253. Please note that IDs cannot
be assigned more than once.

— CANopen node ID
The CANopen node ID can be assigned between 1 and 127. Please note that IDs cannot be
assigned more than once.
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Baud rate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kBit/s and 1 MBit/s, the recommended value being 250 kBit/s.

Modbus
Clicking on the Modbus field enables or disables the Modbus interface on the device.

Modbus Address
The Modbus address can be between 1 and 247. Please note that IDs cannot be assigned
more than once.

Modbus
Please define if the data are transferred in the ASCIl or RTU mode.

Baud rate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9600 and 115200 bit/s, the recommended value being 19200 bit/s.

Parity
Please define if a parity bit is used and if the parity is to be even or uneven. If no parity is

selected, then two stop bits are sent according to Modbus specification, otherwise one stop
bit is sent.

Setting the transfer rate

Please note that all devices connected with a bus must be set to the same
transfer rate.

® Information on logs
Please contact your MOTORTECH contact partner if you require more
information on the CANopen, J1939 and Modbus logs.

NOTICE
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8.11.14 Miscellaneous — Information
This configuration page can be viewed by all users, but changes can only be made with
authorization for the Service access level.

(B3 unnamed.mic3* (MIC3xL.12) - MICT =)
Eile Device Settings Document Jools Help
AHFS 1 %% AOEE ©

| Information
i Site and Module

Configuration Page
# Engine
Parameters Site Description:
| Cylinder Names ity
Ignition Qutputs
| Ignition Coils Module Description:
| Pickups Engine Type Descriptions:
4 Timing
Analog Inputs Service Contact
4 Schedule A Contact Information (i.e. company, name, phone, e-mai):
General
Energy
4 [ ScheduleB
General
Energy
| Miscellaneous
4 Inputs/Outputs
Alarms
| ASO1
Inputs
4 Miscellaneous
Communication

| Information

Q COM3 1D MIC3x1,12 (1.7.1 [0000ac01]) ADV. SERVICE Full Access Version:1.28.2

Site and Module
In this section, enter information on the system and the module for which the configuration will
be used.

Service Contact

In this section, individual contact data can be saved that can be called up and displayed via
MICT.
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8.12 Runtime Data
Click on the symbol to open the window Runtime Data. The following sections will give

you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposal in the toolbar in the window:

Symbol Function

Prints the runtime data.

\Tﬁ'},

Prints the runtime data to a PDF file.

Starts the runtime data trace.
Stops the runtime data trace.

QE Opens the print preview.
\
)
N
LB

o \1? Acknowledges the operating errors. If an operating error is acknowledged, all
% alarms are also simultaneously acknowledged. The symbol is grayed out if no
acknowledged error is present.
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8.12.1 Runtime Data — Overview

2+ MICT - Runtime Data @M
T T = b
<L s=P: SORLINC

Overview | Tming | Ignition | BankA | states | Messagelog | Diagnostics | Temperatures | information |

Speed Device State
- Q@ Idle @ Configuration
(@ Synchronizing @ SelfTest

( Firing Active
Firing Locked

Wait for Stop @ Start Phase
@ Warning O Alarm

@ Error

Contral

( Firing Enabled
(@ Schedule A (Erdgas)
@ GPit

Output
@ GPO1

Failure
(@ Analog Current Input @ Analog Voltage Input

(@ Ignition Output

Timing Misfire Rate
Global Timing Point [Jlll eToc Primary Secondary
Single Output - % - %
Operating Hours A outputs ISR =
spar Piugs | NENEGEGEGEEEEH e - B -

Q COM3 IDMIC3:1.12 (1.7.1 [0000ac0L]) Lifetime: 6:04:23.601

In this screen, you can find the following information:
- Speed Indicator (analog)

— Red Pointer
Displays the current registered speed

— Yellow Pointer
Displays the maximum registered speed since last starting the engine
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— Green Pointer
Display of set overspeed

- Speed Indicator (digital)
Digitally displays the current speed

— Global Timing Point
Digital indication of the current global timing

— Operating Hours
— Spark Plugs
Indicates the current operating hours of the spark plugs
— Engine
Indication of current operating hours of the engine

— Device State
The status of the device is shown by the following status displays:

Idle The ignition is ready and waiting for pickup activity.
Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is

not released.

Wait for Stop Pickup signals are being received, the ignition fired above
the security speed, and the ignition release was retracted.
The engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self test is running (refer to Self Test on page 56).

Start Phase The engine is in the configured start phase (refer to Timing —

Schedule A/B - Energy on page 80).

Warning Awarning occurred (refer to Warnings on page 104).

Error An error occurred (refer to Errors on page 104).

Alarm A configured alarm occurred (refer to Alarms on page 104).
- Control

— Firing Enabled
The green status display signals that the firing is active.

— Schedule A/B
The green status display shows which parameter settings are currently used.
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- GPl1
The status indicator shows the status of the input signal.

- Output

- GPO1
The general purpose output is switched on with the green status display.

— Failure

— Analog Current Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

— Analog Voltage Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again
gray.

— Ignition Output
The red status display signals a current misfire on at least one output. With a yellow
status display at least one misfire has occurred at one output since the last reset of the
counter.

— Misfire Rate
The misfire rate is displayed for the primary side and the secondary side. The misfire rate on
the secondary side is only displayed if the secondary side diagnosis is activated (refer to
Engine — Ignition Coils on page 70).
— Single Output
Displays the misfire rate of the output for which the most misfires were registered
during the last 32 cycles.

— All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

— The number of misfires per second are calculated by the MIC3 as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2
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8.12.2 Runtime Data — Timing

2+ MICT - Runtime Data @M
=g =d = )
< &--0=- JORONC

| Overview | Timing | Igniton | BankA | States | Messagelog | Diagnostics | Temperatwes | Information |

Global Timing Point Calculation

Base Timing + BTDC

RET

I
rer ENEE - R
i ;

RET

Potentiometer Timing +

Analog Current Input Timing +

Analog Voltage Input Timing +

Speed Curve Correction + RET

Timing Correction + -RET

Global Timing Point BTDC

Individual Timing
Minimum ADV

Maximum - ADV
Average - ADV

@ COM3 IDMIC3x1.12 (1.7 [0000ac01]) Lifetime: 6:05:17.601

In this view, the system displays all values and settings in the left hand section that influence
the ignition timing. In the right hand section, values are additionally displayed and shown as a
bar chart that are measured at the three inputs (potentiometer, analog current and voltage
input) and thus cause the changes to the timing shown. The value for the speed curve results
from the curve progression set in the configuration. Refer to the section Timing — Schedule A/B -
General on page 78. The timing correction can be implemented for the runtime. Please refer to
the section Runtime Adjustments — Timing on page 114.
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In the lower range, the maximum, minimum and average of the cylinder individual offsets are
also displayed.

8.12.3 Runtime Data - Ignition

81 MICT - Runtime Data =8

L D)

| Overview Timing [ Igniton | Bank A | States l Message Log | Diagnostics | Temperatures I Information |

Output Cylinder Smn;j;i’{}::f:ge 0 Misfire

I o e e e SR s N
A e e
o ST T 1 3 ©
v BT, T 1 1 0
o N T ©
o EEST Lo T 1 10
Coil Data Version: 0

@ COM3 IDMIC3:d.12 (1.7 [0000ac01)) Lifetime: 6:06:03.601
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The following information is provided:

Column: Output
Designation of the output

Column: Cylinder
If cylinder names have been assigned, these are displayed

Column: Estimated Secondary Voltage [kV]

Secondary voltage determined by the ignition controller of the respective output.

The secondary voltage estimate is used to determine deviations between the individual
outputs. These indicate a possible problem at this output (e. g. problems in the area of the
spark plug or the cylinder).

If you have set the ignition coils (refer to Engine — Ignition Coils on page 70) for which a
secondary voltage estimate does not seem possible "---" appears.

Column: Misfire

The red status display signals a current misfire at the respective output. With a yellow status
display at least one misfire has occurred at the respective output since the last reset of the
counter.

The coil data version configured in the MIC3 is displayed under the ignition runtime data.
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8.12.4 Runtime Data — Bank A
2+ MICT - Runtime Data EM
T ugd = o) rL
<L s~ JORURC

BankA | States | Message Log | Diagnostics | Temperatures | Information ‘
Misfire
Output Cylinder gnge L Primary Secondary
[* Crank] Duration [ps] Output [mJ]

| overview | Timing [ ignition

open short Rate [%] open  shot Rate [%]
~ 1~ Hill B o ol ©0 © Ea
2 v~ Il Bl © ol © © H
~ sHE~ Il B o ol © °©0 =
~ i~ Il Bl o ol © ©0 Ha
~ sHEE~ il B o o lH © ©
s~ ol Il B o o M © O
v sHSE~ IEE B o ol © © B
~ I~ IEE B o ol © © B
~ i~ Il B © o lH ©° ©
co v~ il Bl o ol ©o © A
AN "EE> EE B o ol © © B3
sz ol NN BS © o HE O O EE

Show Firing Angles: @ Relative () Absolute

Q@ COM3 IDMIC3:1.12 (1.7.1 [0000ac0L]) Lifetime: 6:06:31.601

The following information is provided:

- Column: Output
Designation of the output

—  Column: Cylinder
Number of the Cylinder
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— Column: Angle
Current firing angle of the outputs

— Column: Min. Spark Duration
Minimum spark duration of the outputs

- Column: Energy Output
Current energy release of the output

— Columns: Misfire
Status display for the different types of misfires (primary winding, secondary winding, open,
short circuit). In case of misfire, the respective status display turns red, otherwise it is gray.
With a yellow status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-» Send commands
-> Reset misfire counter. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

- Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.
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8.12.5 Runtime Data - States

2+ MICT - Runtime Data @M
T T = b
<L s=P: SORLINC

| overview | Timing | Igniton | BankA | States | Messagelog | Diagnostics | Temperatures | information |

Operating Hours  Time Status Message

3-18 21:16:48 PUL: Synchronization problem

6:14:51.286 201

Q COM3 IDMIC3:1.12 (1.7.1 [0000ac0L]) Lifetime: 6:14:56.112
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Status messages are listed in the Status view.

The following information is provided:

— Operating Hours
Operating hours counter reading at the time of message

- Time
Date and time of the message

— Status Message
Message text

Status messages are displayed in black if they are current. When a status is reset, the status
message is displayed in grey for 10 seconds before it is deleted from the list.

Statusmeldung

Alarm shutdown caused by alarm number.

Analog current input failure (current: x mA, failure threshold: y mA, failure reset threshold:
z mA).

Analog voltage input failure (voltage: x V, failure threshold: y V, failure reset threshold: z V).

Aux analog input supply voltage failure (voltage: u V, desired voltage: v V, failure threshold:
x V, failure reset threshold: y V).

Aux pickup supply voltage failure (voltage: u V, desired voltage: v V, failure threshold: x V,
failure reset threshold: y V).

Configuration data checksum error. Using default configuration.
Configuration invalid. Using previous configuration.

Current sensor of output bank name failed.

General error number.

Global timing x° crankshaft limited to range y° crankshaft .. z° crankshaft.
Incompatible coil parameters received, secondary voltage diagnostics disabled.
Output board identification failed due to a checksum error.

Output board identification failed due to incompatible hardware.

Output board identification failed due to missing data.

Output board identification failed due to unknown error number.

Output board identification failed due to unknown hardware.

Pickup configuration invalid.

Power failure detected on output Anumber.

Power output (x W) exceeded error threshold limit (y W) at a supply voltage of z V.
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Statusmeldung

Power output (x W) exceeded limit (y W) at a supply voltage of z V.

Power output (x W) exceeded permanent limit (y W) at a supply voltage of z V.
PUnumber: Faulty index.

PUnumber: Faulty Signal. Signal period (x, events counted y) is too small compared to
previous signal period (2).

PUnumber: Index mark missing.
PUnumber: Missing index.

PUnumber: Missing Signal. Signal period (x, events counted y) is too great compared to
previous signal period (2).

PUnumber: Missing Signal. Signal timeout occurred (events counted x).
PUnumber: No index mark found.
PUnumber: No signal.

PUnumber: Number of events (x) counted on pickup input PUnumber does not the match the
expected value ().

PUnumber: Operational error.
PUnumber: Polarity detection failed.
PUnumber: Synchronization problem.

PUnumber: Wrong pickup signal polarity on pickup input PUnumber detected. Reversing
polarity internally.

Self test aborted because pickup signals have been detected on pickup input PUnumber.
Speed (x RPM) exceeded overspeed limit (y RPM) at trigger signal number.

Temperature of device (x °C) exceeded error threshold limit (y °C).

Temperature of device (x °C) exceeded limit (y °C).

Temperature of device (x °C) exceeded permanent limit (y °C).

Temperature sensor failed.
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8.12.6 Runtime Data — Message Log
2+ MICT - Runtime Data @M

FHHe B

| overview | Tming | Ioniion | BankA [ states | Messagelog | Diagnostics | Temperatures [ Information |

Operating Hours  Time Category Message =
5:57:50.563 2014-03-18 20:59:39 Error  Operational error caused by pickup signals. PUL = 0x00000000, PU2 = 0x00
5:58:13.943 2014-03-18 21:00:02 Info  Operational error acknowledged.

5:58:22117 2014-03-18 21:00:10 Warning Speed (2393 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
5:58:22121 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w
5:58:22125 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
5:58:22129 2014-03-18 21:00:10 Warning Speed (2396 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
5:58:22133 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
5:58:22138 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
5:58:22142 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
5:58:22146 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
5:58:22150 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
5:58:22154 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
5:58:22159 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
5:58:22163 2014-03-18 21:00:10 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi:
5:58:22.214 2014-03-18 21:00:10  Error  Speed (2396 rpm) exceeded overspeed limit (1800 rpm) at trigger signal 12
5:58:22.214 2014-03-18 21:00:10  Error  Operational error caused by pickup signals. PU1 = 0x00000000, PU2 = 0x00
5:59:33384 2014-03-18 21:01:21 Info  Operational error acknowledged.

6:00:02882 2014-03-18 21:01:51 Warning Speed (2393 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
6:00:02886 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02890 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
6:00:02895 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
6:00:02899 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02503 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02907 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02911 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02815 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
6:00:02920 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed wi
6:00:02524 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed w:
6:00:02928 2014-03-18 21:01:51 Warning Speed (2397 rpm) exceeded overspeed limit (1800 rpm). Previous speed we
6:00:02979 2014-03-18 21:01:51  Eror  Speed (2396 rpm) exceeded overspeed limit (1800 rpm) at trigger signal 12
6:00:02979 2014-03-18 21:01:51  Error  Operational error caused by pickup signals. PU1 = 0500000000, PU2 = 0x00 2
6:01:31448 2014-03-18 21:03:20 Info  Operational error acknowledged.
6:01:40.231 2014-03-18 21:03:28 Alarm  Alarm 1 "speed trip” triggered.

‘ (0 | 3

Eu—

@ COM3 IDMIC3x1.12 (1.7 [0000ac01]) Lifetime: 6:07:31.601

Information, warnings, errors and alarms are listed in the Message Log view.

Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 82.

Errors and appropriately configured alarms shut down the engine.
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The following information is provided:

— Operating Hours

Operating hours counter reading at the time of message
- Time

Date and time of the message

- Category
Type of message (information, warning, error, alarm)

- Message
Message text
You have the following options:

— Automatic Scrolling
If this box is checked, the system automatically displays the last list entry until a new event
occurs.

- Acknowledge Alarms
With this button, you can reset triggered alarms if they are no longer active. An alarm can
only be acknowledged if the checkbox Permanent - Output remains switched on until the
alarm is acknowledged in the alarm configuration is activated.

Acknowledging an operating error

While the engine is in standstill, there are the following options for
acknowledging operating errors:

— Using Error Acknowledge in the MICT

— Restart / Reset

— Hold button PB on the controller longer than three seconds

@ Acknowledging warnings
You can acknowledge a warning by briefly pressing the pushbutton PB on
the controller.

NOTICE
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The following message texts can be displayed:

Information

Access control disabled.

All access control PINs reset.

CAN interface CANnumber entered bus off state.

CAN interface CANnumber left bus off state.

CAN reset requested by GPlnumber.

CANopen on interface CANnumber changed state to "name".

Configuration changed.

Date and time set.

Device (firmware number.number.number.number) started at a supply voltage of x V.
Device reset requested by GPInumber failed because pickup signals have been detected.
Device switched off.

Engine operating hours set to x h.

Failed to change PIN of access control level "number".

Failed to disable access control.

Failed to enable access control.

Failed to reset all access control PINs.

J1939 on interface CANnumber changed state to "name".

One or more messages are lost due to exhausted memory pool or message queue overrun.
Operational error acknowledged.

PIN of access control level "number" changed.

Self test denied because no outputs are configured.

Self test started.

Self test stopped.

Spark plug operating hours set to x h.

Wrong pickup signal polarity on pickup input PUnumber detected. Reversing polarity
internally.
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Configuration data checksum error. Using default configuration.

Configuration invalid. Using previous configuration.

Disable secondary diagnostic due to output Anumber.

Disable secondary diagnostic due to output Bnumber.

General warning number.

Incompatible coil parameters received, secondary voltage diagnostics disabled.
Invalid coil data received.

Pickup configuration invalid.

Power output (x W) exceeded limit (y W) at a supply voltage of z V.

Speed (x RPM) exceeded overspeed limit (y RPM). Previous speed was z RPM.

Temperature of device (x °C) exceeded limit (y °C)

Alarm number "description" acknowledged.
Alarm number "description" triggered.

All alarms reset.

Alarm shutdown caused by alarm number.

Assertion failed (x).

Critical error x (y).

Current sensor failed.

Cycle signal was missing, so more trigger signals were counted than available per cycle.
Device started after supply voltage failure.

General error number.

General error in pickup pre-processing on pickup input PUnumber.

Number of trigger signals (number) counted does not match the configured value.
Operational error caused by pickup signals. PU1 =x, PU2 = y.

Output board identification failed due to a checksum error.
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Output board identification failed due to incompatible hardware.

Output board identification failed due to missing data.

Output board identification failed due to unknown error number.

Output board identification failed due to unknown hardware.

Output board power failure detected on output Anumber.

Power output (x W) exceeded error threshold limit (y W) at a supply voltage of z V.
Power output (x W) exceeded permanent limit (y W) at a supply voltage of z V.
Self test aborted because pickup signals have been detected on pickup input PUnumber.
Speed (x RPM) exceeded overspeed limit (y RPM) at trigger signal number.
Temperature of controller board (x °C) exceeded limit (y °C).

Temperature of device (x °C) exceeded error threshold limit (y °C).

Temperature of device (x °C) exceeded permanent limit (y °C).

Temperature sensor of controller board failed.

Trigger period (x, triggers counted y) is not in acceptable range compared to previous trigger
period (2).

Trigger signal missing. Current trigger period (triggers counted x) is out of the specified
range related to the previous trigger period.
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8.12.7 Runtime Data — Diagnostics

2+ MICT - Runtime Data

(o] ]

L 2--R-SON

v
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V]

| overview | Timing | Igniton | BankA | states | Messagelog | Diagnostics

CAN State

@ Error Active
Controller Board
Supply Voltage [V]

@ Error Passive

Bl =———

Temperatures | Information \

Pickup Input 1 Pre-Trigger [V]

————

—
0

T
2

Pickup Input 2 Pre-Trigger [V]

T
0

T
2

T
4

@ Bus Off

Pickup Input 3 Pre-Trigger [V]
Aux Pickup Supply Voltage [V)
i e —

I T T T T T T T T T 1
0 5 10 15 20 25
Aux Analog Input Supply Voltage [V]
i e ———

I T T T T T T T T T 1
Qutput Board

0 5 10 15 20 25
Power Qutput [W] -

Q@ COM3 IDMIC3:1.12 (1.7.1 [0000ac01]) Lifetime: 6:08:03.601

The following information is provided:

- CAN Status
The status display indicates the current error handling status of the device for the CAN bus
communication:

— Error Active
The device is in normal status of the bus communication. If an error occurs in the
communication, the device sends an active Error Flag.

106 Rev. 11/2014



Error Passive
After a defined number of errors in the bus communication, the device changes to the
status Passive Error. If another error occurs, the device sends a passive Error Flag.

Bus Off
The device is disconnected from the CAN bus due to error accumulations in the bus
communication.

Controller Board

Supply voltage
Current voltage supply of the controller board

Pickup Pre-Trigger Voltage

Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups on page 72).
During operation the pre-trigger voltage for passive pickups is increased depending on
the speed, so that the ignition controller is less prone to interferences.

Aux. Pickup Supply Voltage
Current auxiliary supply voltage of the pickups (refer to Engine — Pickups on page 72)

Aux. Analog Input Supply Voltage
Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on

page 76)

Output Board

Power Output
Current output of the output board
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8.12.8 Runtime Data — Temperatures

21 MICT - Runtime Data =B |a

LT

[ overview | Timing | Igniton | BankA | States | Messagelog | Diagnostics | Temperatuwres | Information |

Controller Board
Current Temp [°C] | R ﬁ
50 0 50 100 150
e Tosp ] | TR —
50 0 50 100 150
Max Temp [°C] - H,.—M
50 0 50 100 150

@ COM3 IDMIC3:d.12 (1.7.1 [0000ac01)) Lifetime: 1:44:10.608

108 Rev. 11/2014



MOTORTECH

In the window you receive an overview of the temperatures of the controller board and the
output board. The maximum and minimum values are reset at each new start of the ignition
controller.

The following information is provided:
— Controller Board

— Current Temp.
Current temperature of the controller board.

- Min. Temp.
Minimum temperature measured on the controller board

— Max. Temp.
Maximum temperature measured on the controller board
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8.12.9 Runtime Data - Information

B3 MICT - Runtime Data = |6

FHH G

| overview | Timing | ignion | BankA | States | Messagelog | Diagnostics | Temperatures | Information |

Device

Device ID MIC3x1.12 (1.7.1 [0000ac01])
Arrangement Number 321.12.C0Q0-000-AA-1

Serial Number 01019195

Bootloader Version 0.28.2.19259

Firmware Version 0.7.0.19460

Operating Hours 1:42:51.608

Controller Board

Serial Number 1IB0000018IB

Hardware Version 0.11.0.18758

Clock

Date and Time Tuesday, March 18, 2014 4:35:35 PM Mitteleuropaische Sommerzeit

@ COM2 IDMIC3:d.12 (1.7 [0000ac01)) Lifetime: 1:42:51.608
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In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department by fax or as
a PDF file by email. For fast support, we will then immediately have all required information.

8.13 Log
Click on the symbol to open the window Log. This window is only available to
E users with authorizations starting at the access level Advanced Service.

B} vacT-Log [E=SICy—=]
| Automatic scroling Log level: |debug -

na Selectfle |

3/14/14 11:04 AM --- DISCONNECT ---

3/14/14 11:04 AM --- CONNECT ---

3/14/14 11:04 AM --- DISCONNECT ---

3/14/14 11:04 AM --- CONNECT -

3/14/14 11:04 AM /src/pickup_signal_handler/pickup_signal_handlercpp (442) select inputs: 010
3/14/14 11:04 AM /src/pickup_signal_handler/pickup_signal_handlercpp (442) select inputs: 110
3/14/14 11:08 AM /src/pickup_signal_handler/pickup_signal_handler.cpp (442) select inputs: 210
3/14/14 11:04 AM /src/pickup_signal_handler/pickup_signal_handlercpp (442) select inputs: 110

The window Log serves to support error diagnostics by MOTORTECH.

— Automatic scrolling
If the function is active, the view panel focuses on the latest message.

- Loglevel
The selection of the log level is specified by MOTORTECH if needed.

- Write log to file
This checkbox activates or disables, respectively, the saving of the logged data in a selected
file. If the function is disabled, the logged data are merely shown on the display.

— Select file
With this button, you can select a file to which you want to save the logged data.
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If you are prompted to create a log file in the case of a service request, proceed as follows:
1. Open the window Log via the toolbar or the menu bar.
2. Select a path with the Select file button and enter the file name for the log file.

» If the file does not yet exist, it is automatically created with the extension .log.

3. Activate the checkbox Write log to file.
4. Select the level specified by MOTORTECH from the Log level list.
5. Leave the window open.

> The log messages are logged both in the window and in the selected file.

8.14 Runtime Adjustments
Click on the symbol to open the window Runtime Adjustments. This window is

only available to users with authorizations starting with access level Service.
@ Runtime adjustments are implemented directly
All runtime adjustments are implemented directly without requiring the
input to be confirmed and are retained even in the case of a MIC3 restart.

Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.

NOTICE
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8.14.1 Runtime Adjustments — Reset

(88 MICT - Runtime Adjustments (=B ]

Reset V{Tmng | Energy | Secondary Voltage Calbraton | Secondary hort Calibration |
reset [-cran) [ ~ov

@ COM3 IDMIC3:d.12 (1.7.1 [0000ac01])

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

- 0,1 ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET
in 0.5° increments to advance or retard

Changes are implemented immediately and stored in the configuration provided in the device.
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If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups on page 72).

8.14.2 Runtime Adjustments — Timing

11 MICT - Runtime Adjustments =
[ Reset I Timing w Energy | Secondary Voltage Calibration ] Secondary Short Calbration |

Timing Correction [SCRANK] - ADV
Global Tming roint [-cran] [N ~ov

(&€0.50v | [ € 0.100v ] [» o.1rer | [ o.srer |

@ COM3 D MIC3x1.12 (1.7.1 [0000ac01))

The global ignition timing position can be corrected by 50°crankshaft (advanced/retarded) while
the device is being operated. The correction is made with the buttons:

-  0.1ADV/RET
in 0.1° increments to advance or retard
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- 0.5ADV/RET
in 0.5° increments to advance or retard

The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 78) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in
place if the device is restarted. NOTICE: The configuration defined in the device is not changed.

8.14.3 Runtime Adjustments — Energy
(85 MICT - Runtime Adjustments e

Reset | Timing Energy | Secondary Voltage Calbration | Secondary Short Calbration |

chedue A
—
spark Intensity (ma] | S
(€om) [(€im]  (3vim] (Brom]
Schedule B

Spark Duration [us] -
& -10ps € -1ps S +ips | [P +10ps

spark intensity (ma] [
(&-oma|[ €-1ma | [§ +ima] [P +ioma]

@ COM3 ID MIC3:1.12 (1.7.1 [0000ac01])
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The energy settings can be separately adjusted for both schedules. Changes are implemented
immediately and stored in the configuration provided in the device.

Spark Duration
- +/-1ps

lengthen or shorten in microsecond increments
- +/-10ps

lengthen or shorten in 10 ps increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10mA

increase and decrease in 10 mA increments
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8.14.4 Runtime Adjustments — Secondary Voltage Estimation Calibration

(B4 MICT - Runtime Adjustments (=6 [
[ Reset | Timing | Energy | Secondary Voltae Caibration | Secondary Short Calbration |
All Qutputs
[ &-05 |[ €-01 | Reset |[ »+01 |[ P+os |
Output Offset -0.5 -0.1 +0.1 +0.5
a1 El « | < ][ » [ »
%2  « | < ][ > ][ » |
a3 El « | < [ > ][ » |
ad e « | < ][ » ][ » ]
s  « [ < [ > J[ »
s e « | ¢ ) J »
a7 el « | < ] » ][ »
s e « ) < . » [ »
20  « ) < ] > ] » ]
A10 S « (¢ ] » ][ » |
S « | ¢ . » [ »
€« ) < [ > [ » )

@ COM3 1D MIC3x1.12 (1.7.1 [0000ac01])

The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be indicated for the secondary voltage estimation for every
output to increase the accuracy of the secondary voltage estimation for each individual cylinder.
E. g. this allows different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made using the relevant global or individual cylinder buttons. The value
range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.
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Changes are implemented immediately and stored in the configuration provided in the device.

8.14.5 Runtime Adjustments — Secondary Short Calibration

M1 MICT - Runtime Adjustments =
[ Reset | Timing | Energy E Secondary Voltage Calibration ‘ Secondary Short Calibration |
Secondary Short Enable Voltage
Secondary Short Enable Voltage [kV] U _ Reset }
Secondary Short Sensitivity

Secondary Short Sensitivity -
[ o1 |[ dkoor | [ dkooos| ek oo

[ =01 |[ =001 | [ == o0.001 | [= o0.0001]

@ COM3 IDMIC3x1.12 (1.7.1 [0000ac01])

The starting voltage and sensitivity for the secondary short-circuit monitoring can be adjusted.

Changes are implemented immediately and stored in the configuration provided in the device.
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Secondary Short Enable Voltage [kV]:
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

— The secondary short-circuit monitoring is always activated at a value of o kV.

— The secondary short-circuit monitoring is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

E. g. set the sensitivity of the short-circuit monitoring as follows:
— The sensitivity is high at a value of 0.98.

— The sensitivity is low at a value of 1.02.

Adjust the sensitivity of the secondary short detection

If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity
must be set to 1.02.

EXAMPLE If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity must
be set to 0.98.

8.15 Cylinder Individual Offsets
Click on the symbol to open the window Cylinder Individual Offsets. This

window is only available to users with authorizations starting with access level
Service.

’E} MICT - Cylinder Individual Offsets =REC)

Dt ofbetd 0.5 -+ 0.1 0.1 T 0.5
AL = | 3 [ € ] [ 2 Il » ]
w2 I = L« L ¢ JL > JC» |
4 I = e ¢ 3 % ]
A I = C« JC ¢ JC 3> . » ]
as I = L« . ¢ J 2> | » |
" I - L« JL.. € JL. &% JL.®» |
w I - L« L ¢ JL > JC» ]
i I = L« L€ ] L. » |
A9 - RET [ « ] l <€ I [ > ] [ » 1
4 I e ) ¢ J 2 Ji.®» |
All - RET | « 1 | € I [ ) i [ » 1
azz I = L& J[L. < JL 2 J[.» |
Q COM2 1D MIC3:d 12 (1.7.1 [00002<01))
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The cylinder individual offset can be applied to the position of the timing point while the
controller is being operated. Offset via keys:

- 0.1ADV/RET
in 0.1° increments to advance or retard

- 0.5ADV/RET
in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 78.

Immediate execution of the changes

Please note that changes made to the timing point are executed
immediately at the next firing of the corresponding cylinder. The maximum
performed change per cycle is however limited by the corresponding setting
in the configuration. For this read Timing — Miscellaneous on page 81.

Save changes automatically

Please remember that changes to the ignition timing are saved
automatically.

8.16 Schedule Curve
. Click on the symbol to open the window Schedule.
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8.16.1 Schedule Curve — Simulation

4 MICT - Schedule (= [E

[¥] smulation 30.0 BTDC

25.0 BTDC i

20.0 BTDC |

15.0 BTDC

f/
D
3 = -
I ;
2
]
Timing [°CRANK]

10.0 BTDC

0.00V

< 0
0

5.0 BTDC

0.0 ATDC —i+
r

F=T——T—=T=—Te= S A s e
(1] 500 1.000 1.500 2.000
Speed [RPM]

— MnTimng — MaxTimng — Min Speed Curve Timing — Max Speed Curve Tming — Speed Curve & Current speed

@ COM3 ID MIC3x1.12 (1.7.1 [0000ac01])

The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs via the speed range. With the optional input fields, you can switch between schedule
A and B. Changes made by turning the control buttons or entering the desired values are
displayed simultaneously.

—  Simulation
The simulation is activated or disabled using the checkbox.

— Potentiometer
Simulation of the potentiometer

— Control button for adjustments between o % and 100 %
— Field for manual input of the desired value in %

— Displays the value in °crankshaft by which the timing is offset
— Analog Current Input
Simulation of the analog current input
— Control button for adjustments between the configured values (e. g. 0 mA and 20 mA)
— Field for manual input of the desired value in mA
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— Displays the value in °crankshaft by which the timing is offset
— Analog Voltage Input
Simulation of the analog voltage input
— Control button for adjustments between the configured values (e. g. o Vand 10 V)
— Field for manual input of the desired value in V
— Displays the value in °crankshaft by which the timing is offset
— Schedule A/B
Select between schedule A and B.
— Timing Point

Displays the global ignition timing as it changes during the simulation

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as # in the diagram.

8.16.2 Schedule Curve - Runtime Values
If the Simulation box is unchecked, the Schedule curve window switches to the current runtime

data.

11 MICT - Schedule lo]E ]
[ smulation 30.0 BTDC —f? -
Runtime Values 1
Schedule
Schedue: A
SR 25.0 8TDC B
- -

Analog Current Input
I - . o ]
Analog Voltage Tnput 20.0 BTDC
— J
. .o
e =
RPM i
[ 1] S s
Timing Point o 4
I : |
ATDC E :
a ]
10.0 BTDC
5.0 8TDC B e
0.0 ATDC i+
B T e S S
0 500 1.000 1.500 2.000
Speed [RPM]
— MnTming — MaxTiming — Min Speed Curve Timng — Max Speed Curve Timing — Speed Curve 4 Current speed
@ COM3 ID MIC3:1.12 (1.7.1 [0000a01])
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The following information is provided:

— Schedule
Displays the currently selected schedule.

— Left column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the new calculated adjustment values for the potentiometer, current and voltage
input.

— Right column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the values supplied by the ignition controller for the potentiometer, current and
voltage input.

— Speed
Displays the current speed

— Timing Point
Displays the current global ignition timing

8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the
database as follows:

Tools -> Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the
Coils window:

Symbol Function

Stores the information on the selected ignition coils in a format that is
appropriate for configuring the MIC3 via fieldbus.
Prints the selected coil data set.

Prints the selected coil data set as a PDF file.

Opens the print preview.

g@ @ \Tﬁ}, m

Coils
— Device

Select an ignition controller.
- Coil

Select an ignition coil.
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Select the correct ignition controller

The ignition coil data depends on the ignition controller used. Always select
the ignition controller for which you are using the coils in order to obtain
the correct data.

8.17.1 General

B MICT - Coils =68
FEile
CEECE
Cois General | Min, Energy Limit Curve
Device: [MIC3 - Detai
Col: [06.50.100 Nome: 06.50.105
06.50.102 Col Type Id: 4
joecn1o4 Data Version: 2
06.50.105
06.50.108
06.50.112
06.50.300
95.09.100
95.00.156
Secondary dagnostics avadable if max. breakdown voltage i set in range 38 kV to 40 kv Additonally it &
requirad that the enargy invt is set sufficently hiph according to the min. energy lnvt curve.
Coll Parameters
Parameter Min. Max.
Max, Breakdown Voltage (kV] 19 w0
Spark Intensity [mA] 3z 150
Secondary Voltage Estimation Calbraton 5 5
Secondary Short Sensitvity 0.98 102
Details
The following information is provided:
- Name
Coil name
- Coil Type ID

Used to clearly identify the ignition coil

- Data Version
Shows the data version of the selected ignition coil in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the
Ignition view (refer to Runtime Data — Ignition on page 94). The Automatic Online Update
should be activated to ensure that the coil database always has the latest data sets.
Additional information on the online update is provided in Online Update Settings on

page 55.
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Illustration of the ignition coil

Information on the conditions under which a secondary diagnosis is possible using the
displayed ignition coil.

Coil Parameters
The following information is provided:

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The
maximum breakdown voltage is configured in the Timing — Schedule A/B — Energy view
(refer to Timing — Schedule A/B — Energy on page 80).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the Timing — Schedule A/B — Energy view (refer to Timing — Schedule A/B -
Energy on page 80).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The
secondary voltage estimation calibration takes place in the Engine — Ignition Coils view
(refer to Engine — Ignition Coils on page 70) and in the runtime adjustments (refer to Runtime
adjustments — Secondary Voltage Estimation Calibration on page 117).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the Engine — Ignition Coils view
(refer to Engine — Ignition Coils on page 70) and in the runtime adjustments (refer to Runtime
adjustments — Secondary Short Calibration on page 118).
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8.17.2 Minimum Energy Limitation Curve

B MICT - Coils =68

File
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Cais | General | Min. Energy Limit Curve
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@
=

25 30 3
Max. Breakdown Voltage [kV]
— Min. Energy Limit = Min, Max. Limit Secondary Diagnostics

Min. Energy Limit Curve

The curve provides information on the energy in m) necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the
Timing — Schedule A/B — Energy view (refer to Timing — Schedule A/B — Energy on page 80).

When printing the coil data set, the curve values are also provided as a list.
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9.1 Start-up

Before you start up the MIC3 ignition controller, take note of the following:

— Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

— Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

— Is the wiring of all pickups compliant with the drawings given in this operating manual?

- Are the distances of the pickups to trigger discs, projectiles, etc. correctly set (refer to
Determine the Installation Location of the Pickup on page 22)?

— Ensure that the data were transferred flawlessly to the controller.

— Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

— Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

— Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
— Ensure that the gas valve is closed.
—  Perform the normal engine start-up process while the gas valve is closed (start only).

— Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft.
If the ignition timing point does not coincide exactly, change it (refer to Runtime Data on
page 89) until the optimum setting is reached. If the ignition does not fire, read the
instructions in section Troubleshooting and Eliminating Errors on page 132.

— Checkall other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

— Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

9.2 Shut-Down
The ignition controller is shut down by disconnecting it from the power supply.

9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can perform a firmware update for the ignition controller.
The provided CD-ROM comprises this program.
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Install MOTORTECH Flash Tool
This is how to install the MOTORTECH Flash Tool:

1.

Start the installation.

— Insert the CD-ROM into the CD/DVD drive of your PC. If the Autostart function is enabled
for the drive, cancel the installation program for the MOTORTECH Integrated
Configuration Tool if necessary.

— Copy the MOTORTECHFlashTool-x.x.x.zip file (e. g. MOTORTECHFlashTool-0.8.3.zip) to
your PC.

— Unzip thefile.

— Start the installation process by running the unzipped setup.exe file.

Install the program.

Follow the installation process instructions. Please note that the license agreement terms

must be accepted before using the MOTORTECH Flash Tool. If the terms are not accepted, the
installation cannot continue.

If not already completed, install the USB driver by running the CDMxxxxx_Setup.exe file (e. g.
CDM20824_Setup.exe) on the CD-ROM.

» The MOTORTECH Flash Tool is now set up. You can connect your PC to the ignition
controller via the USB interface.

Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

Symbol Menu Function

é& @

128

= File -> Open Opens a firmware file.

File -> Quit Exits the program.

View -» Extended File Information ~ Fades in / out additional information of the

View firmware file.

View -» Extended Connection Fades in / out additional information and

Settings settings of the connection to the device.

View -> Reload File Reloads the file information of the selected
firmware file.

Device -» Search Devices Restarts the search for connected devices.

Rev. 11/2014



% Device -> Program Device Starts the update process or downgrade
h .‘g process.
Settings -> Language Opens the window Select Language in

which you can change the interface
language of the program.

Help -»> Help Opens the online help function.

Help -> About MOTORTECH Flash Opens detailed information on the
Tool program.

Start Firmware Update

® Access control for firmware update
If you have activated the access control for the ignition controller, you need
the PIN for the level Master for the firmware update.

NOTICE

Backup the existing configuration

Your device's configuration may be lost if the firmware update is not
performed properly. Always backup the existing configuration via the MICT
prior to performing an update. For further information please refer to
Working with Configurations on page 61.

To start the firmware update, proceed as follows:
1. Ifan MICT is connected with the ignition controller, please disconnect this connection.

2. Start the MOTORTECH Flash Tool via Start -» Programs -> MOTORTECH -» MOTORTECH Flash
Tool -» x.x.x (e. g. 0.8.3) -> MOTORTECH Flash Tool.

» The MOTORTECH Flash Tool will now start.
> The software automatically checks all ports for connected devices.
3. Check whether your device has been correctly identified in Status under Device.

» If the MOTORTECH Flash Tool does not recognize a device that is connected to your PC
via the USB interface, you can usually still carry out a firmware update. To do so,
observe the instructions in the information windows of the MOTORTECH Flash Tool for
the following steps.
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130

Select the desired update file in File using the Select button.

By reading the displayed file information, ensure that the update file is correct for your
device.

Start the update process using the Flash button or using the menu or toolbar.
» Theignition controller is restarted automatically.

» Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.

Please confirm with Yes to proceed with the update process.
> Now the update will start.
> If the firmware update was successful, you will see a relevant message.

After a successful firmware update, check all configuration data.

Downgrade process

The process for a downgrade is largely the same as the update process. You
will only be informed that a new firmware has been installed on the device.

Help with connection problems

If a correctly connected device is not found during the automatic search,
this can, for example, be because too many communication interfaces are
assigned and must be checked. In this case an interface from the drop-
down list Port in area connection can be selected and thus specified.

If the desired port is not yet displayed in the list or if the problem should
continue, an adjustment of the time-outs for the connection helps. The
time-out settings are displayed in the main view by the following entry in
the menu bar: View -» Extended connection settings.

Enter the following settings:

— Update Request Timeout
Adjustment range: 1000 ms to 10000 ms, default value: 3000 ms. An
extension of the time-out can be an advantage, especially with
connection problems that occur because the computer has many
assigned ports.

— Start Timeout
Adjustment range: 1000 ms to 10000 ms, default value: 3000 ms. A
time-out change can be an advantage, especially with connection
problems that occur because the communication between the computer
and the device has been interrupted.
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10 DISTURBANCES

10.1 Possible Faults
The MIC3 ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

—  Output Error Detection

— Shut down in the case of a faulty pickup or faulty pickup signals.
- Alarms

— Faulty voltage supply

— External EMI signals

10.2 Causes for Faults

10.2.1 Overspeed
The engine speed has exceeded the set overspeed value.

Potential causes:
— Speed controller does not function properly
— Fuel supply to engine is not optimal.

—  Faulty pickup signal

10.2.2 Qutput Error Detection
An internal failure of the high voltage supply or a defective output switch occurs.

Potential causes:
— Hardware defect on the MIC3

— Defectin the wiring (short circuit or open circuit)

10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential causes:
— Defect in the output wiring

— Ignition coil defective
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10 DISTURBANCES

10.2.4 Pickup Input Errors
Faulty input signals from the pickups are detected.

Potential causes:

- Number of teeth on the flywheel does not coincide with the set number.
— Interference in the wiring of the pickup

- Wiring of the pickup incorrect

— Distance of the pickup incorrect

- Dirt on the pickup

10.2.5 Acknowledging Faults
While the engine is shut down, you have the following options for acknowledging operating
errors:

- Using Error Acknowledge in the MICT
- Acknowledgement of the error via CAN bus or RS485.
— Bydisconnecting the supply voltage

10.3 Troubleshooting and Eliminating Errors

10.3.1 Running a Self Test

You can run the self test via the MICT to check the order of the wiring and the connection
between the ignition controller outputs and the spark plugs. For this read section Self Test on
page 56.

Operational safety!

If you carry out a self-test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.
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10.3.2 Causes of Typical Errors
The table defines possible causes of errors that are dealt with in the MICT status and message

texts.

Issue

Trigger number

Trigger signal
missing

Cycle signal missing

Reset number

Rev. 11/2014

Description

Number of events per cycle
counted does not correspond
with set value.

Number of counted events is
smaller than expected number.

Cycle signal was not detected in
time. More events were counted
than is expected per cycle.

Number of reset events are
outside expected range.

Causes

Set value is wrong.
Ring gear is defective.
Trigger disk runs out-of-center

Faults on reset, index
camshaft/crankshaft

Reset is polarized incorrectly.
Pickup is dirty.

Pickup
wiring is damaged.

Defective connection to the
pickup

Reset is polarized incorrectly.

Contaminations have
occurred on the trigger disk
during operation.

Trigger disk / ring gear was
damaged during operation.
Pickup wiring

is defective.

Reset is polarized incorrectly.

Faults on reset, index
camshaft/crankshaft
occurred.

Wiring to
camshaft/crankshaft pickup
is defective.

Trigger signal was jammed.

NOTICE

Only for 4-stroke engines:
Interference coupling on reset
signal.
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10 DISTURBANCES

Issue Description

Trigger period Current event period is outside
the valid range with reference to
the previous event period.

Pickup Pickup

preprocessing preprocessing causing errors.

Overspeed Overspeed

Shutdown due to
alarm

The ignition is shut down due to
an alarm.

Temperature The max. permissible device

temperature was exceeded.

The self test was aborted
because pickup signals were
detected.

Pickup signals in the
self test

Recognition of output Characteristic data of the output
board failed board could not be read, they are
defective or do not match the

device.
Interruption of power The HV power supply reported an
supply to the output  error.
board

Current sensor
error

Errors occurred during current
measurement.

Limit for temperature The error is triggered if the
exceeded device temperature exceeds a
specific value.

Limit for output
exceeded

The error is triggered if the
output exceeds a specific value.

134

Causes

Interference coupling on
trigger signal

The wiring to the trigger
pickup is defective.

The trigger pickup is dirty.

Trigger disk / ring gear was
damaged during operation.

NOTICE
N+1 / N-1 trigger discs

Overspeed
Interference coupling on
trigger signal

The limit set for an alarm
resulting in engine shut-down
was exceeded or not reached.

Ambient temperature too high

Interference coupling on
pickup
signal.

Engine was started.

NOTICE
Send the device to MOTORTECH.

NOTICE
Send the device to MOTORTECH.

Sensor defective

Ambient temperature too high

The supply voltage is not
sufficient for the entered
energy settings.
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A list with status messages is provided in Runtime Data — States on page 98.

Lists with information, alarm, warning and error messages are provided in Runtime Data —
Message Log on page 101.

10.3.3 Customer Service Information

You can reach our customer service during business hours at the following phone and fax
number, or by e-mail:

Phone: +4951419399 0

Fax: +49 514193 99 99

Email:  service@motortech.de

10.3.4 Returning Equipment for Repair / Inspection
To return the device for repair and inspection, obtain a return form and return number from
MOTORTECH.

Fill out the return form completely. The completely filled out return form guarantees fast,
uncomplicated processing of your repair order.

Send the device and the return form to one of the two addresses below or to the nearest
MOTORTECH representative:

MOTORTECH GmbH MOTORTECH Americas, LLC
Hogrevestr. 21-23 1400 Dealers Avenue, Suite A
29223 Celle New Orleans, LA 70123
Germany USA

Phone: 449514193990 Phone:  +1504 355 4212
Fax: +49 514193 99 98 Fax: +1 504 355 4217
www.motortech.de www.motortechamericas.com
motortech@motortech.de info@motortechamericas.com

10.3.5 Instructions for Packaging the Equipment
For return shipment, equipment should be packaged as follows:

— Use packaging material that does not damage the equipment surfaces.
—  Wrap the equipment with sturdy materials and stabilize it inside the packaging.

— Use sturdy adhesive film to seal the packaging.
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11 MAINTENANCE

11.1 Maintenance Instructions
Please follow the following maintenance instructions:

— Do not use caustic liquids or steam cleaners for cleaning the device.
- Clean the passive pickups at regular intervals.
- Check the ignition wires at regular intervals.

- Replace the pickups at regular intervals if operating at elevated temperatures
(>90°C/>194°F).

- Regularly inspect all wires of the ignition system for damage and replace the wires as
needed.

- Check all plug-in connections for proper condition.

- Service the spark plugs as per the instructions of the spark plug and engine manufacturers.

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC3 ignition systems, please refer to our current product
guide, which is available to you for download on the Internet at www.motortech.de.
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